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Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two

conditions:

* This device may not cause harmful interference; and

* This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance
with manufacturer s instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.
« Increase the separation between the equipment and receiver.

«  Connect the equipment to an outlet on a circuit different from that to which the receiver
is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

R The use of shielded cables for connection of the monitor to the graphics card is required to
assure compliance with FCC regulations. Changes or modifications to this unit not expressly
approved by the party responsible for compliance could void the user s authority to operate

this equipment.
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RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision DNEIERAE

AEMEEH  Macrovision \NHEIRIRRFERER - ZEREE TS HF T
ﬁlﬂm‘% P BLEREE R AT A FRAE Macrovision 2\ FEIHZHE » BRAFIAGBE K B TR EREt EE
» FRIERR Macrovision FHIEIHE » B8 k6 TAZBHFAR L EAT -

Lithium-lon Battery Warning

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer s instructions.
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Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:
+ This device may not cause harmful interference; and

+  This device must accept any interference received including interference that
may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy
and, if not installed and used in accordance with manufacturer’ s instructions,
may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

»  Reorient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

» Connect the equipment to an outlet on a circuit different from that to which
the receiver is connected.

+  Consult the dealer or an experienced radio/TV technician for help.

R The use of shielded cables for connection of the monitor to the graphics card is
required to assure compliance with FCC regulations. Changes or modifications to
this unit not expressly approved by the party responsible for compliance could
void the user’ s authority to operate this equipment.

RF exposure warning

This equipment must be installed and operated in accordance with provided
instructions and the antenna(s) used for this transmitter must be installed to
provide a separation distance of at least 20 cm from all persons and must not be
co-located or operating in conjunction with any other antenna or transmitter. End-
users and installers must be provide with antenna installation instructions and
transmitter operating conditions for satisfying RF exposure compliance.



Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

This class B digital apparatus complies with Canadian ICES-003.
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Copyright © 2010 ASUSTeK Computer Inc. All Rights Reserved.

No part of this manual, including the products and software described in it, may be reproduced,
transmitted, transcribed, stored in a retrieval system, or translated into any language in any form or by any
means, except documentation kept by the purchaser for backup purposes, without the express written
permission of ASUSTeK Computer Inc. (‘ASUS”).

Product warranty or service will not be extended if: (1) the product is repaired, modified or altered, unless
such repair, modification of alteration is authorized in writing by ASUS; or (2) the serial number of the
product is defaced or missing.

ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL ASUS, ITS
DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS,
LOSS OF BUSINESS, LOSS OF USE OR DATA, INTERRUPTION OF BUSINESS AND THE LIKE),
EVEN IF ASUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY
DEFECT OR ERROR IN THIS MANUAL OR PRODUCT.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED FOR
INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE,
AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ASUS. ASUS ASSUMES NO
RESPONSIBILITY OR LIABILITY FOR ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS
MANUAL, INCLUDING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.

Products and corporate names appearing in this manual may or may not be registered trademarks or
copyrights of their respective companies, and are used only for identification or explanation and to the
owners’ benefit, without intent to infringe.
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Notices

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://green.asus.com/english/REACH.htm

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:
+  This device may not cause harmful interference.

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:
+  Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

+  Consult the dealer or an experienced radio/TV technician for help.

R The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.



vi

RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice

This product incorporates copyright protection technology that is protected by method

claims of certain U.S. patents and other intellectual property rights owned by Macrovision
Corporation and other rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home and other limited viewing
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering
or disassembly is prohibited.

Lithium-lon Battery Warning

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.




Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent
and a few drops of warm water then remove any extra moisture with a dry cloth.

+ DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has
been damaged.

+ DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.

+ DO NOT place or drop objects on top and do not shove any foreign objects into the
Desktop PC.

+ DO NOT expose to strong magnetic or electrical fields.

+ DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during
electrical storms.

+  Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the
contacts. DO NOT disassemble the battery.

+ Use this product in environments with ambient temperatures between 0°C (32°F)and
35°C (95°F).

+ DO NOT cover the vents on the Desktop PC to prevent the system from overheating.

+ DO NOT use damaged power cords, accessories, or other peripherals.

- To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

+  Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

- Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

+  Ifthe power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.

vii
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Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

9. DANGER/WARNING: Information to prevent injury to yourself
when trying to complete a task.

'\ CAUTION: Information to prevent damage to the components
. when trying to complete a task.

IMPORTANT: Instructions that you MUST follow to complete a
task.

NOTE: Tips and additional information to help you complete a
task.

N 9

Where to find more information

Refer to the following sources for additional information and for product and software
updates.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS website www.asus.com.

ASUS Local Technical Support

Visit ASUS website at http://support.asus.com/contact for the contact information of
local Technical Support Engineer.


http://www.asus.com
http://support.asus.com/contact

Package contents

=/

ASUS Essentio Desktop PC

Mouse x1 (Optional)

<D

Power cord x1

AC power adapter x1

Support DVD x1

Tnstehetion Gude

Nanranig,
=

Recovery DVD x1

Installation Guide x1

Warranty card x1

% + If any of the above items is damaged or missing, contact your retailer.

- + Theillustrated items above are for reference only. Actual product specifications may vary

with different models.

+ Keyboard and mouse may not be included in some regions.

AEN

serviceability.

ASUS reserves the right to replace components or accessories to provide optimal






Getting started

Welcome!

Thank you for purchasing the ASUS Essentio CS6110 Desktop PC!

Encased in a compact and portable system casing, the ASUS Essentio CS6110 Desktop
PC provides you with a high-definition 1080p display resolution and supports high quality
surround sound technologies.

R Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

Getting to know your computer

/ lllustrations are for reference only. The ports and their locations, and the chassis color vary
L with different models.

Front panel

/ Click the number to view its corresponding description.

ASUS CS6110 1-1



1.  ODD eject button. Push to eject the optical disk drive tray.
2. Front I/O ports cover. Pull to open the front panel.

3.  CIRreceiver. This receives infrared signal from a remote controller.

% The remote controller is purchased separately.

4,  Wireless network/Bluetooth LED.

5.  Hard disk drive LED.

6.  Power button. Press this button to turn on your computer.

7.  MMC/SD/MS card reader. Insert MMC / SD / MS card into this card slot.

8.  IEEE 1394a port. This 6-pin IEEE 1394a port provides high-speed connectivity for

audio/video devices, storage peripherals, PCs, or portable devices.

9.  USB 3.0 ports. These Universal Serial Bus 3.0 (USB 3.0) ports connect to USB 3.0
devices.

10. Microphone port. This port connects to a microphone.
11. Headphone port. This port connects to a headphone or speaker.

Rear panel

% Click the number to view its corresponding description.
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1. Power (DC) input. Insert the AC adapter into this port.

2. HDMI port. This port allow your computer to connect to an HDMI monitor or other
HDMI-compatible devices.

3. USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

4.  Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or
8-channel configuration, the function of this port becomes Front Speaker Out.
Microphone port (pink). This port connects to a microphone.

Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel
audio configuration.

7.  Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio
sources.

8.  Center/Subwoofer port (orange). This port connects to the center/subwoofer
speakers.

9.  Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and
8-channel audio configuration.

/ Refer to the audio configuration table below for the function of the audio ports in a 2, 4, 6,

- or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration
Al 4-channel 6-channel 8-channel
2-channel
Light Blue Line In Line In Line In Line In
Lime I Line Out I Front Speaker Out I Front Speaker Out I Front Speaker Out
ik | Miem | Mic In | Mic In | Mic In
Orange I - I - I Center/Subwoofer I Center/Subwoofer
Black I - I Rear Speaker Out I Rear Speaker Out I Rear Speaker Out
Gray | - | - | - | side Speaker Out
10. LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN)

through a network hub.

Activity/Link LED Speed LED ACIéL[I)NK SEEED
| |
OFF No link OFF 10Mbps connection [y -
ORANGE | Linked | ORANGE | 100Mbps connection
BLINKING | Dataactivity | GREEN | 1Gbps connection
LAN port

ASUS CS6110



11.

12.

13.

/'\
/ \
L] J

VGA port. This port allows your computer to connect to a VGA monitor or other VGA-
compatible devices.

Kensington® Lock port. This port allows you to secure your Desktop PC to a fixed
object using Kensington® compatible security products.

Air vents. These vents allow air ventilation.

DO NOT block the air vents on the chassis. Always provide proper ventilation for your
computer.

Chapter 1: Getting started



Setting up your computer

This section guides you through connecting the main hardware devices, such as the external
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor

Using the ASUS Graphics Card

Connect your monitor to the display output port on the discrete ASUS Graphics Card.
To connect an external monitor using the ASUS Graphics Card:

1. Connect a monitor to a display output port on the ASUS Graphics Card.

2. Plug the monitor to a power source.

% The display output ports on the ASUS Graphics Card may vary with different models.

ASUS CS6110




Connecting a USB keyboard and a USB mouse (Optional)

Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your
computer.

% Keyboard and mouse may not be included in some regions.

Connecting the AC adapter
To connect the AC adapter:
1. Connect the AC power cord to the AC adapter.

2. Connect the AC adapter to the DC-in port at the back of your
computer.

3. Connect the AC adapter to a power outlet.

1-6 Chapter 1: Getting started



Turning your computer ON/OFF

This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON
To turn your computer ON:
1. Turn your monitor ON.

Press the power button on your computer.

Wait until the operating system loads automatically.

Turning your computer OFF
To turn your computer OFF:

1. Close all running applications.
2. Click E on the Windows® desktop.
3. Click [IEMEHEEIEN 10 shut down the operating system.

ASUS CS6110
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Using Windows® 7

Starting for the first time

When you start your computer for the first time, a series of screens appear to guide you in
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1. Turn your computer on. Wait for a few minutes until the Set Up Windows screen
appears.

From dropdown list, select your language. Click Next.

From the dropdown lists, select your Country or region, Time and currency, and
Keyboard layout. Click Next.

4. Key in unique names for the user name and computer name. Click Next.

5. Key in the necessary information to set up your password, then click Next. You may
also click Next to skip this step without entering any information.

% If you want to set up a password for your account later, refer to the section Setting up a
- user account and password in this chapter.

Carefully read the license terms. Tick | accept the license terms and click Next.

7. Select Use recommended settings or Install important updates only to set up the
security settings for your computer. To skip this step, select Ask me later.

8. Review your date and time settings. Click Next. The system loads the new settings and
restarts. You may now start using your computer.

ASUS CS6110 214
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Using Windows® 7 desktop

% Click the Start icon H > Help and Support to obtain more information about Windows® 7.

Start
menu

Taskbar

Notification area

Using the Start menu

The Start menu gives you access to programs, utilities, and other useful items on your
computer. It also provides you with more information about Windows 7 through its Help and
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1. From the Windows® taskbar, click the Start icon ﬂ

2. From the Start menu, select the item that you want to launch.

% You may pin programs that you want constantly displayed on the Start menu. For more
details, refer to the section Pinning programs on the Start menu or taskbar on this
chapter.

Chapter 2: Using Windows® 7



Using the Getting Started item

The Getting Started item on the Start menu il » =
contains information about some basic tasks such  §g v vsuioe .
as personalizing Windows®, adding new users, and e i "
transferring files to help you to familiarize yourself i o
with using Windows® 7. . >
To use the Getting Started item: TIg—
1. From the Windows® taskbar, click the Start lF" il

icon E to launch the Start menu. -:l .
2. Select Getting Started. The list of available 4

tasks appears. b
3. Select the task that you want to do. i

L]

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

. From the Windows® taskbar, click an icon to launch it. Click the icon again to hide the
program.

% You may pin programs that you want constantly displayed on the taskbar. For more details,
- refer to the section Pinning programs on the Start menu or taskbar on this chapter.

ASUS CS6110




Pinning items on the jumplists
Pin ki 1t sl
When you right-click an icon on the taskbar, a "r_bm

jumplist launches to provide you with quick-access
to the program’s or item’s related links.You may
pin items on the jumplist such as favorite websites,

often-visited folders or drives, or recently played
media files. Al Windowy Medis Player
o Ungin this progeam from tekbar

- luw:wwhn
e Play all e

To pin items to the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that
you want to pin, then select Pin to this list.

Unpinning items from the jumplist
To unpin items from the jumplist:
1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that you want to remove from the jumplist, then
select Unpin from this list.

Pinning programs on the Start menu or taskbar
To pin programs on the Start menu or taskbar:

B e Oy
S Ml ettt i

1. From the Windows® taskbar, click the Start icon b
A

to launch the Start menu. EE: R
2. Right-click the item that you want to pin on the " npagton | [ttt =)

T Amilina il

Start menu or taskbar.
3. Select Pin to Taskbar or Pin to Start menu.

You may also right-click on the £ Al Manages 10700
icon of a running program on
the taskbar, then select Pin this
program to taskbar.

N

= Pin this pregram to taskbar

[ Close windew
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Unpinning programs from the Start menu
To unpin programs from the Start menu:

1. From the Windows® taskbar, click the Start icon E to launch the Start menu.

2. From the Start menu, right-click the program that you want to unpin, then select
Remove from this list.

Unpinning programs from the taskbar

To unpin programs from the taskbar:

1. From the taskbar, right-click the program I = Mecrosot Office Word 207

that you want to remove from the taskbar, | @ Unpin this progeam from taskbar
then select Unpin this program from —

=

taskbar. ] o ’E )

Using the

notification area

By default, the notification area shows these three icons:

Action Center notification

Click this icon to display all the alert messages/notifications and launch the Windows®
Action Center.

Network connection

This icon displays the connection status and signal strength of the wired or wireless network
connection.

Volume

Click this icon to adjust the volume.

Displaying

To display an alert notification:

an alert notification

- Click the Notification icon [, then click I 1 meiage

the message to open it.

W Sl up backup

DOpen Bchan Cenker

7

For more details, refer to the section Using Windows® Action Center in this chapter.

ASUS CS6110
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Customizing icons and notifications

You may choose to display or hide the icons and notifications on the taskbar or on the
notification area.

To customize icons and notifications:

1. From the notification area, click on the arrow icon E
Click Customize.

3. From the dropdown list, select the behaviors for the icons or items that you want
customize.

) e e e rad B e apymae e P kb

B e e el e n i e by e g = e 1w
iy T

- B—
b —r— ——— -
Rt ——e—

iy s p— -

S e B e e Bt
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Managing your files and folders

Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1. From the Windows® taskbar, click the Start icon E to launch the Start menu.

2. Click Computer to launch Windows Explorer.

Breadcrumb bar View icon
S AT BT S — Search bar
TOOIDAr L i Rarhisin s B A . ety Preview icon
[ —
ey -
e e
PY-— -
[ L i
e ] -
Navigation —f— H' == —{— View pane
ane y—
p B waei
-~
.h e *

Exploring files and folders
To explore files and folders:
1. Launch Windows Explorer.
From the navigation or view pane, browse for the location of your data.

From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

ASUS CS6110
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Customizing the file/folder view
To customize the file/folder view:
1. Launch Windows Explorer.

2. From the navigation pane, select the location of your
data.

From the toolbar, click the View icon = =.

From the View menu, move the slider to select how you
want to view the file/folder.

26 Exira Lowge Joons

= Large bicnt
35 Medium leom

BE Senall keon

/ You may also right-click anywhere Anane by
Lo on the View pane, click View, and Vrem

select the view type that you want. Sort by

3 Extim large soem

L2 Large iczoa
Mg mong
Grnall g

Arranging your files
To arrange your files:

1. Launch Windows Explorer.

2. From the Arrange by field, click to display the dropdown list.

3. Select your preferred arrangement type.

Chapter 2: Using Windows® 7



Sorting your files

To sort your files:

1. Launch Windows Explorer.
Right-click anywhere on the View pane.
From the menu that appears, select Sort

by, then select your preferred sorting type.

Grouping your files
To group your files:
1. Launch Windows Explorer.
Right-click anywhere on the View pane.

From the menu that appears, select
Group by, then select your preferred
grouping type.

Adding a new folder
To add a new folder:

drangs by

ia
fart by
Camig by
Erlreih

Paiti
Pt bt

ks Cpy

i

1. Launch Windows Explorer.

2. From the toolbar, click New folder.

Drganize = Share with =

Burn

Mew folder

3. Keyin aname for the new folder.

% You may also right-click anywhere
L on the View pane, click New >

Folder.

ASUS CS6110
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Backing up your files

Setting up a backup
To set up a backup:

1. Click E > All Programs > Maintenance > Backup and Restore.
2. Click Set up backup. Click Next.

e o e BB R B

Luweni Faithsrn
Rark ugr iw iritere e Eled

L.
B i s

Frdawn Darng ki waf boen et L

3. Select your backup destination. Click Next.

4.  Select Let Windows choose (recommended) or Let me choose as your backup
mode.

% If you select Let Windows choose, Windows will not back up your programs, FAT-
- formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5. Follow the onscreen instructions to finish the process.

Restoring your system

The Windows® System Restore feature creates a restore point where the computer’s system
settings are stored at certain time and date. It allows you to restore or undo changes to your
computer’s system settings without affecting your personal data.

To restore your system:

1. Close all running applications.

2. Click E > All Programs > Accessories > System Tools > System Restore.

3. Follow the onscreen instructions to complete the process.
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Protecting your computer

Using Windows® 7 Action Center

Windows® 7 Action Center provides you with alert notifications, security information, system
maintenance information, and the option to automatically troubleshoot and fix some common
computer problems.

% You may customize the notifications. For more details, refer to the previous section
Customizing icons and natifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1. To launch Windows 7 Action Center, click "* i

the Notification icon E, then click Open
Action Center. #p Lot e hackup

Open Achon Center
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Using Windows® Update
Windows Update allows you to check and install the latest updates to enhance the security
and performance of your computer.

Launching Windows® Update

To launch Windows® Update:

1. From the Windows® taskbar, click the Start icon E to launch the Start menu.
2. Select All Programs > Windows Update.

3. From the Windows Update screen, click the task that you want to do.
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Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

1.

From the Windows® taskbar, click E > Getting Started > Add new users.

2. Select Manage another account.
3. Select Create a new account.
4. Key in the name of the new user.
5. Select either Standard user or Administrator as the user type.
6.  When done, click Create Account.
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Setting up a user’s password

To set up a user’s password:

1. Select the user that you would like to set a password.
2. Select Create a password.

3. Keyinapassword and confirm it. Key in your password’s hint.
4. When done, click Create password.
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Activating the anti-virus software

Trend Micro Internet Security is a pre-installed anti-virus software on your computer. After
activating it, you have a 60-day trial period before the software expires and you need to
purchase a licensed version.

To activate Trend Micro Internet Security:

1. Run the Trend Micro Internet Security application.

2 Carefully read the license terms. Click Agree & Activate.

3. Key in your e-mail address and select your location. Click Next.
4

Click Finish to complete the activation.

Getting Windows® Help and Support

Windows® Help and Support provides you with guides and answers in using the applications
in Windows® 7 platform.

To launch Windows® Help and Support, click E > Help and Support.

s Bwes nppee sobory
B S o v

% Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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Connecting devices to your computer

Connecting a USB storage device

This desktop PC provides USB 3.0/USB 2.0 ports on both the front and rear panels. The USB
ports allow you to connect USB devices such as storage devices.

To connect a USB storage device:

Insert the USB storage device to your computer.

Front panel Rear panel

To remove a USB storage device:

1. Click ¥ from the Windows notification area on your S0, Open Devices and Prink
computer, then click Eject USB2.0 FlashDisk.
T

o T B

R T

2. When the Safe to Remove Hardware message | g <. 1o fermave Hardware

pops up, remove the USB storage device from The 56 Mt Seeige Daicr’ devid cam now bt Safcly
1o from ha campan

your computer. ! m

/ . . .
/A DO NOT remove a USB storage device when data transfer is in progress. Doing so may
cause data loss or damage the USB storage device.
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Connecting microphone and speakers

This desktop PC comes with microphone ports and speaker ports on both the front and
rear panels. The audio /O ports located on the rear panel allow you to connect 2-channel,
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic

AUDIO
INPUTS

Chapter 3: Connecting devices to your computer



Connecting 4-channel Speakers

AUDIO  AUDIO
INPUTS INPUTS

Rear
4 W v i N
)

o )

Connecting 6-channel Speakers

AUDIO AUDIO AUDIO
INPUTS INPUTS INPUTS

ONONO

Rear  Front Center/
Subwoofer
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Connecting 8-channel Speakers
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Connecting multiple external displays

Your desktop PC comes with VGA, HDMI, and DVI ports and allows you to connect multiple
external displays.

R When a graphics card is installed in your computer, connect the monitors on the output
ports of the graphics card.

Setting up multiple displays

When using multiple monitors, you are allowed to set display modes. You can use the
additional monitor as a duplicate of your main display, or as an extension to enlarge your
Windows desktop.

To set up multiple displays:

1. Turn off your computer.

2. Connect the two monitors to your computer and connect the power cords to the
monitors. Refer to Setting up your computer section in Chapter 1 for details on how
to connect a monitor to your computer.

% For some graphic cards, only the monitor that is set to be the primary display has display
- during POST. The dual display function works only under Windows.

ASUS CS6110
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Turn on your computer.
Do any of the following to open the Screen Resolution setting screen:
+  Click E > Control Panel > Appearance and Personalization > Display >
Change display settings.
. Right click anywhere on your Windows desktop. When the pop-up menu appears,
click Personalize > Display > Change display settings.
5. Select the display mode from the Multiple displays: dropdown list.

+  Duplicate these displays: Select this option to use the additional monitor as a
duplicate of your main display.

+  Extend these displays: Select this option to use the additional monitor as an
extension display. This increases your desktop space.

+ Show desktop only on 1/2: Select this option to show the desktop only on
monitor 1 or monitor 2.

+  Remove this display: Select this option to remove the selected display.
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6.  Click Apply or OK, then click Keep Changes on the confirmation message.
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer.

+ You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is
purchased separately.

+ To get the best display performance, ensure that your HDMI cable is less than 15
meters.

ASUS CS6110
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Using your computer

Proper posture when using your Desktop PC

When using your Desktop PC, maintaining the proper posture is necessary to prevent strain
to your wrists, hands, and other joints or muscles. This section provides you with tips on
avoiding physical discomfort and possible injury while using and fully enjoying your Desktop

PC.
Eye level to the top of
the monitor screen 1
<

90° angle
Foot rest

To maintain the proper posture:

Position your computer chair to ensure that your elbows are at or slightly above the
keyboard to get a comfortable typing position.

. Adjust the height of your chair to make sure that your knees are slightly higher than
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level
of your knees.

. Adjust the back of your chair so that the base of your spine is firmly supported and
angled slightly backward.

Sit upright with your knees, elbows, and hips at an approximately 90° angle when you
are in front of your PC.

Place the monitor directly in front of you, and adjust the top of the monitor screen within
your eye level so that your eyes look slightly downward.

Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to
reduce the pressure on your wrists while typing.

. Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare
such as windows and direct sunlight.

Take regular mini-breaks from using your Desktop PC.
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Using the memory card reader

Digital cameras and other digital imaging devices use memory cards to store digital picture or
media files. The built-in memory card reader on the front panel of your system allows you to
read from and write to different memory card drives.

To use the memory card:

1. Open the front I/O ports cover.
2. Insert the memory card into the card slot.

/ + Amemory card is keyed so that it fits in only one direction. DO NOT force the card into a
slot to avoid damaging the card.

+ You can place the media in one or more of the card slots and use each media
independently. Place only one memory card in a slot at one time.

3. Select a program from the AutoPlay window to access your files.

% + If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the
- taskbar, click Computer, and then double-click the memory card icon to access the data
onit.

+ Each card slot has its own drive icon and it is displayed on the Computer screen.

The memory card reader LED lights up and blinks when data is being read from or
written to the memory card.

4. When finished, right-click the memory card drive icon on the Computer screen, click
Eject, and then remove the card.

R Never remove cards while or immediately after reading, copying, formatting, or deleting
data on the card or else data loss may occur.

y /E \ To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows
) notification area before removing the memory card.
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Using the optical drive

Inserting an optical disc
To insert an optical disc:

1.

While your system is on, press the eject button to open the tray.

2 Place the disc to the optical drive with the label side facing up.

3. Push the tray to close it.

4 Select a program from the AutoPlay window to access your files.

/ If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar,
. click Computer, and then double-click the CD/DVD drive icon to access the data on it.

Removing an optical disc
To remove an optical disc:

1.

2.

While the system is on, do either of the following to eject the tray:
+  Press the eject button.
Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.

Remove the disc from the disc tray.

—~
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Connecting to the Internet

Wired connection
Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network
(LAN).

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1. Set up your DSL/cable modem.

/ Refer to the documentation that came with your DSL/cable modem.

2. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to a DSL/cable modem.

Turn on the DSL/cable modem and your computer.
Configure the necessary Internet connection settings.

/ Contact your Internet Service Provider (ISP) for details or assistance in setting up your
- Internet connection.

ASUS CS6110
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Connecting via a local area network (LAN)
To connect via a LAN:

1. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to your LAN.

2. Turn on your computer.

3. Configure the necessary Internet connection settings.

% Contact your network administrator for details or assistance in setting up your Internet
— connection.
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Using the utilities

ASUS Al Manager

ASUS Al Manager is a utility which gives you quick and easy access to frequently-used
applications.

Installing Al Manager
To install Al Manager:

1. Place the support DVD in the optical drive. If Autorun is enabled, the Drivers installation
wizard appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Al Manager folder in
the support DVD.

2. Click the Utilities tab, then click ASUS Al Manager.
3. Follow the onscreen instructions to complete the installation.

Launching Al Manager
To launch Al Manager from the Windows® desktop, click Start > All Programs > ASUS > Al
Manager > Al Manager 1.xx.xx. The Al Manager quick bar appears on the desktop.

[© DeeesH

After launching the application, the Al Manager icon appears in the Windows® taskbar.
Right-click this icon to switch between the quick bar and the
main window, and to launch the Al Manager either from the
quick bar or taskbar.

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit
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Al Manager quick bar

The Al Manager quick bar saves the desktop space and allows you to launch the ASUS
utilities or display system information easily. Click any of the Main, My Favorites, Support or
Information tab to display the menu’s contents.

: Exit button
@ ﬁ % Switch to main Window
| e Add to ToolBar

Main Support

My Favorites Information

Click the Maximize/restore button Il to switch between full window and quick bar. Click the
Minimize button B to keep the Al Manager on the taskbar. Click the Close button = 1o quit
the Al Manager.

Main

The Main menu contains five utilities: Al Disk, Al Security, Al Boosting, and Al Probe. Click
the arrow on the Main menu icon to browse through the utilities in the main menu.

."m?"r"ﬂ=’ I-I
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ﬁ Al Maneger

1

Click to display
items on the
right

Click to extend or restore

Click to display-
items on the left

Al Disk

Al Disk allows you to easily clear temporary IE files, IE cookies, IE URLs, IE history,
or the Recycle Bin. Click the Al Disk icon on the quick bar to display the full Al Disk
window and select the items you want to clear. Click Apply when done.
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Al Security
Al Security enables you to set a password to secure your devices, such as USB flash
disks and CD/DVD disks, from unauthorized access.

To lock a device:

1. When using Al Security for the first time, you are asked to set a password. Key in
a password with at most 20 alphanumeric characters.

2. Confirm the password.
Key in the password hint (recommended).
When done, click Ok.
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Select the device you want to lock, then click Apply.
6. Key in the password you have set previously, then click Ok.

To unlock the device:
1. Deselect the locked device, then click Apply.
2. Key in the password you have set previously, then click Ok.

To change the password:

Click Change Password, then follow the onscreen instructions to change
password.

ASUS CS6110
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Al Booting

Al Booting allows you to specify the boot device priority sequence.

S
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To specify the boot sequence:

1. Select a device, then click the left/right button to specify the boot sequence.

2. When done, press Apply.

Al Probe

Al Probe automatically detects and displays the motherboard and CPU temperatures,
CPU fan speed, and the voltage output. You can adjust the values as you need.

Click the Temperature, Voltage, or Fan Speed tab, then select an item to enable and

change the value by dragging the bar.
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My Favorites

My Favorites allows you to add applications that you frequently use, saving you from
searching for the applications throughout your computer.

To add an application:
1. Click Add, then locate the application you want to add to My Favorites.
2. Click Open on the file location window. The application is added to My Favorites list.

Right click on the application icon to launch, delete, or rename the selected application. You
can also double click to launch the selected application.

Support

Click any links on the Support window to go to the ASUS website, technical support website,
download support website, or contact information.
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Information

Click the tab on the Information window to see the detailed information about your system,
motherboard, CPU, BIOS, installed device(s), and memory.
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CPU Level Up

CPU Level Up allows you to overclock immediately with OC profile presets in
Windows® environment without the hassle of entering the BIOS setup.

To launch CPU Level Up:
1. Launch Al Manager.
2. Click Asus Utility, then double-click CPU Level Up.
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ASUS Update

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® environment.

+ ASUS Update requires an Internet connection either through a network or an Internet
Service Provider (ISP).

+ This utility is available in the support DVD that comes with the motherboard package.

Installing ASUS Update
To install ASUS Update:

1. Place the support DVD in the optical drive. The Drivers menu appears.

% If Autorun is disabled, double-click the setup.exe file from the ASUS Update folder in the
~ support DVD.

2. Click the Utilities tab, then click Install ASUS Update.

3. Follow the onscreen instructions to complete the installation.

%{ Quit all Windows® applications before you update the BIOS using this utility.

Updating the BIOS
To update the BIOS:

1. From the Windows® desktop, click Start > Programs > ASUS > ASUS Update >
ASUS Update to launch the ASUS Update utility.

2. From the dropdown list, select any of the updating process:

Updating from the Internet
a. Select Update BIOS from the Internet, then click Next.

b.  Select the ASUS FTP site nearest you to avoid network traffic, or click Auto
Select then click Next.

c. From the FTP site, select the BIOS version that you wish to download then click
Next.

% The ASUS Update utility is capable of updating itself through the Internet. Always update
the utility to avail all its features.

Updating from a BIOS file
a. Select Update BIOS from a file, then click Next.

b. Locate the BIOS file from the Open window, then click Open.
3. Follow the onscreen instructions to complete the updating process.

ASUS CS6110
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ASUS MyLogo™

The ASUS MyLogo™ utility lets you customize the boot logo. The boot logo is the image that
appears on screen during the Power-On Self-Tests (POST). ASUS MyLogo™ is automatically
installed when you install the ASUS Update utility from the Support DVD.

R + Obtain the latest BIOS file from the ASUS website at www.asus.com.

+ You can create your own boot logo image in GIF file format.

To launch ASUS MyLogo™:

1.

6-8

Launch the ASUS Update utility. Refer to the section “ASUS Update” in this user
manual for details.

Select Options from the drop down menu, then click Next.

Check the option Launch MyLogo to replace system boot logo before flashing
BIOS, then click Next.

Select Update BIOS from file from the drop down menu, then click Next.

When prompted, locate the new BIOS file, then click Next. ASUS MyLogo window
appears.

From the left window pane, locate the
image that you want to use as your boot
logo. Click Next.

From the Ratio dropdown list, select your
desired size for the boot logo. Click Next.

The system starts updating the BIOS and
loading the new boot logo.

After the updating process, the system
restarts and displays the new boot logo
during POST.
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Nero 9

Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data.

Installing Nero 9
To install Nero 9:

1. Insert the Nero 9 DVD into your optical drive.
2. If Autorun is enabled, the main menu appears automatically.

% If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero
9 DVD.

3. From the main menu, click Nero 9 Essentials.
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4.

5.

6.

Select the language you want to use for Installation Wizard. Click Next.
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7. Select Typical then click Next.
P———— . -y
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8.  Tick Yes, | want to help by sending anonymous application data to Nero then click

9. When done, click Exit.
- -
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Burning files
To burn files:

1. From the main menu, click Data Burning > Add.
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2. Select the files that you want to burn. When done, click Add.
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3. After selecting the files that you want to burn, click Burn to burn the files to a disc.
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% For more details about using Nero 9, refer to the Nero website at www.nero.com

Recovering your system

The bundled Recovery DVD assists you in reinstalling the operating system and restoring it
to its original working state.

/| '\ All data will be lost during the recovery process. Before recovering the system, ensure
[ e \ that you back up all your data and take note of any customized settings such as network
settings.

To recover your system:

1. Turn on your ASUS Desktop PC. When the ASUS logo appears, press <F8> to enter
the Please select boot device menu.

2. Insert the recovery DVD into the optical drive and select the optical drive (CDROM:
XXX) as the boot device. Press Enter and then press any key to continue.

3. Wait until the Hard-Disk Information screen appears. Select where to install a new
system. Options are:

Recover system to a partition

This option deletes only the partition you selected, allows you to keep other partitions,
and creates a new system partition as drive “C.” Select a partition and click NEXT.

Recover system to entire HD

This option deletes all partitions from your hard disk drive and creates a new system
partition as drive “C.” Select and click Yes.
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Tick | accept then click Next.
Follow the onscreen instructions to complete the recovery process.

Click OK on the confirmation message to eject the disc from the optical drive and the
system restarts.

After the system restarts, Windows® 7 begins its system configurations. Follow the
onscreen instructions to complete the process, and the system automatically restarts.

R This recovery DVD is for ASUS Desktop PC only. DO NOT use it on other computers. Visit

the ASUS website www.asus.com for any updates.

Quickly recover your system

1.

Turn on your ASUS Desktop PC. When the ASUS logo appears, press F9 to enter
System Recovery.

Windows is loading files is shown. Wait until the Recovery CD/DVD window
appears.

Follow the onscreen instructions to complete the recovery process. After the system
reboots, display resolution and system settings are restored to their default values.
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Troubleshooting

Troubleshooting

This chapter presents some problems you might encounter and the possible solutions.

? My computer cannot be powered on and the power LED on the front
panel does not light up

Check if your computer is properly connected.
. Check if the wall outlet is functioning.

. Check if the Power Supply Unit is switched on. Refer to the section Turning
your computer ON/OFF in Chapter 1.

? My computer hangs.

Do the following to close the programs that are not responding:

1. Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard,
then click Start Task Manger.

2. Click Applications tab.

3. Select the program that is not responding, then click End Task.

If the keyboard is not responding. Press and hold the Power button on the top
of your chassis until the computer shuts down. Then press the Power button to
turn it on.

? I cannot connect to a wireless network using the ASUS WLAN Card
(on selected models only)?

Ensure that you enter the correct network security key for the wireless network
you want to connect to.

. Connect the external antennas (optional) to the antenna connectors on the
ASUS WLAN Card and place the antennas on the top of your computer
chassis for the best wireless performance.

?  The arrow keys on the number key pad are not working.

Check if the Number Lock LED is off. When the Number Lock LED is on,

the keys on the number key pad are used to input numbers only. Press the
Number Lock key to turn the LED off if you want to use the arrow keys on the
number key pad.
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No display on the monitor.

Check if the monitor is powered on.

Ensure that your monitor is properly connected to the video output port on your
computer.

If your computer comes with a discrete graphics card, ensure that you connect
your monitor to a video output port on the discrete graphics card.

Check if any of the pins on the monitor video connector is bent. If you discover
bent pins, replace the monitor video connector cable.

Check if your monitor is plugged to a power source properly.

Refer to the documentation that came with your monitor for more
troubleshooting information.

When using multiple monitors, only one monitor has display.

Ensure that the both monitors are powered on.

During POST, only the monitor connected to the VGA port has display. The
dual display function works only under Windows.

When a graphics card is installed on your computer, ensure that you connect
the monitors to the output port on the graphics card.

Check if the multiple displays settings are correct. Refer to section
Connecting multiple external displays in Chapter 3 for details.

My computer cannot detect my USB storage device.

The first time you connect your USB storage device to your computer,
Windows automatically installs a driver for it. Wait for a while and go to My
Computer to check if the USB storage device is detected.

Connect your USB storage device to another computer to test if the USB
storage device is broken or malfunctions.

I want to restore or undo changes to my computer’s system settings
without affecting my personal files or data.

The Windows® System Restore feature allows you to restore or undo changes
to your computer’s system settings without affecting your personal data such
as documents or photos. For more details, refer to the section Restoring your
system in Chapter 2.

Chapter 7: Troubleshooting



?  The picture on the HDTV is stretched.

It is caused by the different resolutions of your monitor and your HDTV. Adjust
the screen resolution to fit your HDTV. To change the screen resolution:

1. Do any of the following to open the Screen Resolution setting screen:

+ Click > Control Panel > Appearance and Personalization >
Display > Change display settings.

+ Right click anywhere on your Windows desktop. When the pop-up
menu appears, click Personalize > Display > Change display
settings.

2. Adjust the resolution. Refer to the documentation came with your HDTV
for the resolution.

3. Click Apply or OK. Then click Keep Changes on the confirmation
message.

? My speakers produce no sound.

Ensure that you connect your speakers to the Line out port (lime) on the front
panel or the rear panel.

Check if your speak is connected to a electrical source and turned on.

Adjust your speakers’ volume.

Ensure that your computer’s system sounds are not Muted.
If it is muted, the volume icon is displayed as m . To enable the system
sounds, click m from the Windows notification area, then click = #s .

+  Ifitis not muted, click m and drag the slider to adjust the volume.

Connect your speakers to another computer to test if the speakers arer
working properly.

?  The DVD drive cannot read a disc.

=)

1.

Check if the disc is placed with the label side facing up.

Check if the disc is centered in the tray, especially for the discs with
non-standard size or shape.

Check if the disc is scratched or damaged.

The DVD drive eject button is not respond.

Click ﬁ > Computer.

o &
2. Right-click il ™PFWE™= 4 on click Eject from the menu.

ASUS CS6110
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Erklarungen
REACH

Die rechtliche Rahmenbedingungen fur REACH (Registration, Evaluation, Authorisation,
and Restriction of Chemicals) erfullend, verodffentlichen wir die chemischen Substanzen in
unseren Produkten auf unserer ASUS REACH-Webseite unter

http://csr.asus.com/english/REACH.htm

Erklarung der Federal Communications Commission

Dieses Gerat stimmt mit den FCC-Vorschriften Teil 15 Uiberein. Sein Betrieb unterliegt
folgenden zwei Bedingungen:
+  Dieses Gerat darf keine schadigenden Interferenzen erzeugen, und

+  Dieses Gerat muss alle empfangenen Interferenzen aufnehmen, einschlieBlich
derjenigen, die einen unerwunschten Betrieb erzeugen.

Dieses Gerat ist auf Grund von Tests fur Ubereinstimmung mit den Einschrankungen

eines Digitalgerats der Klasse B, gemaB Teil 15 der FCC-Vorschriften, zugelassen.

Diese Einschrankungen sollen bei Installation des Gerats in einer Wohnumgebung auf
angemessene Weise gegen schadigende Interferenzen schutzen. Dieses Gerat erzeugt und
verwendet Hochfrequenzenergie und kann, wenn es nicht gemaB den Anweisungen des
Herstellers installiert und bedient wird, den Radio- und Fernsehempfang empfindlich storen.
Es wird jedoch nicht garantiert, dass bei einer bestimmten Installation keine Interferenzen
auftreten. Wenn das Gerat den Radio- oder Fernsehempfang empfindlich stort, was sich
durch Aus- und Einschalten des Gerats feststellen lasst, ist der Benutzer ersucht, die
Interferenzen mittels einer oder mehrerer der folgenden MaBnahmen zu beheben:

+  Empfangsantenne neu ausrichten oder an einem anderen Ort aufstellen.

+  Den Abstand zwischen dem Gerat und dem Empfanger vergroBern.

+  Das Gerat an die Steckdose eines Stromkreises anschlieBen, an die nicht auch der
Empfanger angeschlossen ist.

«  Den Handler oder einen erfahrenen Radio-/Fernsehtechniker um Hilfe bitten.

k Um Ubereinstimmung mit den FCC-Vorschriften zu gewahrleisten, miissen abgeschirmte
Kabel fur den Anschluss des Monitors an die Grafikkarte verwendet werden. Anderungen
oder Modifizierungen dieses Gerats, die nicht ausdriicklich von der fur Ubereinstimmung
verantwortlichen Partei genehmigt sind, konnen das Recht des Benutzers, dieses Gerat zu
betreiben, annullieren.
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RF-Aussetzungswarnung

Dieses Gerat und die integrierte Antenne durfen nicht naher als 20 cm an Ihrem Korper oder
in der Nahe befindenden Personen installiert und betrieben werden. Dieses Gerat und seine
Antenne(n) durfen nicht zusammen oder in der Nahe mit anderen Antennen oder Sendern
betrieben werden. Endnutzer mussen die spezifischen Betriebsanleitungen fur eine RF-
Aussetzung innerhalb der anerkannten Bereiche befolgen.

Erklarung des kanadischen Ministeriums fur Telekommunikation

Dieses Digitalgerat Uberschreitet keine Grenzwerte fur Funkrauschemissionen der Klasse
B, die vom kanadischen Ministeriums fur Telekommunikation in den Funkstorvorschriften
festgelegt sind.

Dieses Digitalgerat der Klasse B stimmt mit dem kanadischen ICES-003 uiberein.

Macrovision Corporation-Produktanmerkung

Dieses Produkt verfugt iber Kopierschutztechnologie, die durch methodische

Anforderungen bestimmter U.S.A.-Patente und anderer geistiger Eigentumsrechte der
Macrovision Corporation und anderer Parteien geschutzt sind. Die Verwendung dieser
Kopierschutztechnologie muss von Macrovision Corporation genehmigt werden und ist,
wenn nicht anderweitig von der Macrovision Corporation genehmigt, nur fur private
oder eingeschrankte Vorfuhrungszwecke vorgesehen. Reverse-Engineering oder Demontage
ist verboten.

Warnung: Lithium-lonen-Akkus

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.

VORSICHT! Explosionsgefahr bei unsachgemaBen Austausch der Batterie. Ersatz nur
durch denselben oder einem vom Hersteller empfohlenem ahnlichen Typ. Entsorgung
gebrauchter Batterien nach Angaben des Herstellers.




Sicherheitsinformationen

R Bevor Sie das Gerat reinigen, trennen Sie es von der Stromversorgung. Wischen Sie den
Desktop PC mit einem weichen Tuch oder einem Fensterleder ab, das Sie mit einer Losung
aus einem nicht scheuernden Reinigungsmittel und einigen Tropfen warmem Wasser
angefeuchtet haben. Wischen Sie verbleibende Feuchtigkeit mit einem trockenen Tuch ab.

NICHT auf ungerade oder instabile Oberflachen aufstellen. Bei Beschadigung des
Gehauses den Kundendienst aufsuchen.

KEINER schmutzigen oder staubigen Umgebung aussetzen. Kein Betrieb wahrend eines
Gaslecks.

KEINE Gegenstande auf die Oberflache fallenlassen und keine Fremdgegenstande in
den Desktop PC einfuhren.

KEINEN magnetischen oder elektrischen Feldern aussetzen.
KEIN Aussetzen oder Betreiben in der nahe von Flussigkeiten, Regen oder Feuchtigkeit.
KEIN Modembetrieb wahrend eines elektrischen Sturms.
Akku-Sicherheitswarnung: Batterie NICHT in offenes Feuer werfen. Kontakte NICHT
kurzschlieBen. Den Akku NICHT auseinandernehmen.

+  Dieses Produkt in Umgebungstemperaturen zwischen 0°C (32°F) und 35°C (95°F)
verwenden.

+  Die Lufteinlasse des Desktop PCs NICHT abdecken, um eine Uberhitzung des Systems
zu vermeiden.
KEINE beschadigten Stromkabel, Zubehbrteile oder andere Peripheriegerate
verwenden.
Den Kabel zur Vermeidung eine Stromschlags aus der Steckdose herausziehen, bevor
das System bewegt wird.
Suchen Sie Fachpersonal auf, bevor ein Adapter oder Verlangerungskabel verwendet
wird. Solche Gerate kbnnen den Schutzkreislauf fur die Erdung unterbrechen.
Die Netzteilspannung sollte der drtlichen Stromversorgung entsprechen. Falls
Sie sich Uber die Spannung der Stromversorgung unsicher sind, wenden Sie sich an
Ihren Stromversorger.
Falls das Netzteil ausfallt, reparieren Sie es nicht selbst. Wenden Sie sich an
qualifiziertes Fachpersonal oder lhren Handler.
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Darstellungssystematik

Um sicherzustellen, dass Sie bestimmte Aufgaben richtig ausfuhren, beachten Sie bitte die
folgenden Symbole und Schriftformate, die in diesem Handbuch verwendet werden.

) '{\ GEFAHR/WARNUNG: Informationen zum Vermeiden von
( ) Verletzungen beim Ausfuhren einer Aufgabe.

.\ VORSICHT: Informationen zum Vermeiden von Schaden an den
A Komponenten beim Ausfuhren einer Aufgabe.

R WICHTIG: Anweisungen, die Sie beim Ausfiihren einer Aufgabe
befolgen mussen.

/ HINWEIS: Tipps und zusatzliche Informationen zur Erleichterung
bei der Ausfuhrung einer Aufgabe.

Weitere Informationsquellen

An den folgenden Quellen finden Sie weitere Informationen und Produkt- sowie Software-
Updates.

ASUS-Webseiten

ASUS-Webseiten enthalten weltweit aktualisierte Informationen Uber ASUS-Hardware
und Softwareprodukte. ASUS-Webseiten sind in den ASUS-Kontaktinformationen
aufgelistet. Besuchen Sie ASUS unter www.asus.com

Vor-Ort Technische Unterstuitzung

Besuchen Sie die ASUS-Webseite unter http:/support.asus.com/contact fur
Kontaktinformationen der Technischen Unterstiitzung vor Ort.
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ASUS Essentio Desktop PC

Maus x1 (Optional)

D)

Netzkabel x1 Netzteil (Wechselstrom) x1

Support-DVD x1

estaleiion Gude

Wiederherstellungs-DVD x1 Benutzerhandbuch x1 Gewahrleistungskarte x1
% + Sollten 0.g. Artikel beschadigt oder nicht vorhanden sein, wenden Sie sich bitte an lhren
Handler.

+ Die oberhalb illustrierten Artikel sind nur zur Referenz gedacht. Die tatsachlichen
Produktspezifikationen kbnnen sich je nach Modell unterscheiden.

Maus und Tastatur werden nicht in allen Regionen mitgeliefert.

R ASUS behalt sich das Recht vor, Komponenten oder Zubehor zu verandern, um optimale

Betriebsfahigkeit zu ermoglichen.



Willkommen!

Vielen Dank fur den Kauf eines ASUS Essentio CS6110 Desktop PCs

Umhllt von einem kompakten und mobilen Systemgehause, liefert der ASUS Essentio
CS6110 Desktop PC High-Definition 1080 Anzeigeauflosung und unterstutzt hochqualitative
Surround-Sound-Technologien.

R Lesen Sie die ASUS Gewahrleistungskarte sorgfaltig durch, bevor Sie lhren ASUS Desktop
PC in Betrieb nehmen.

Kennenlernen des Computers

/ Abbildungen werden nur zu lhrer Referenz bereitgestellt. Anschlusse und deren Platzierung
- sowie Gehausefarben variieren mit verschiedenen Modellen.

Forderseite

/ Klicken Sie auf die Nummer, um die entsprechende Beschreibung aufzurufen.
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Auswurftaste fur optisches Laufwerk. Drucken Sie diese Taste, um das Laufwerk zu
offnen.

Vordere E/A-Abdeckung. Abdeckung offnen, um an die Fronttafel zu gelangen.

CIR-Empfanger. Empfangt Infrarot-Signale einer Fernbedienung.

Die Fernbedienung muss separat erworben werden.

4. LED fur Drahtlos-Netzwerk/Bluetooth.

5.  LED fur Festplattenlaufwerk.

6. Einschalttaste. Driicken Sie diese Taste, um Ihren Computer einzuschalten.

7. MMC- / SD- / MS-Kartenleser. Fuhren Sie MMC- / SD- / MS-Karten in diesen
Kartensteckplatz ein.

8.  IEEE 1394a-Anschluss. Dieser 6-pol. IEEE 1394a-Anschluss bietet
Hochgeschwindigkeitsverbindungen fur Audio-/Videogerate, Speicherperipherie, PCs
oder andere mobile Gerate.

9.  USB 3.0-Anschlusse. Diese Universal Serial Bus 3.0 (USB 3.0)-Anschliisse nehmen
USB 3.0-Gerate auf.

10. Mikrofonanschluss. Dieser Anschluss verbindet mit einem Mikrofon.

11.  Kopfhoreranschluss. Dieser Anschluss verbindet mit Kopfhorern oder Lautsprechern.

Ruckseite

Klicken Sie auf die Nummer, um die entsprechende Beschreibung aufzurufen.

Kapitel 1: Erste Schritte



10.

Stromanschluss (Gleichstrom). Verbinden Sie das Netzteil mit diesem Anschluss.

HDMI-Anschluss. Dieser Anschluss verbinden mit einem HDMI-Monitor oder anderen
HDMI-kompatiblen Geraten.

USB 2.0-Anschlusse. Diese Universal Serial Bus 2.0 (USB 2.0)-Anschlusse nehmen
USB 2.0-Gerate wie Maus, Drucker, Kamera, PDA und andere Gerate auf.

Line Out-Anschluss (hellgruin). Dieser Anschluss verbindet mit Kopfhorern oder
Lautsprechern. In 4-Kanal-, 6-Kanal- und 8-Kanalkonfigurationen wird dieser Anschluss
zum Frontlautsprecherausgang.

Mikrofonanschluss (rosa). Dieser Anschluss verbindet mit einem Mikrofon.

Seitenlautsprecherausgang (grau). Dieser Anschluss verbindet in einer 8-Kanal-
Audiokonfiguration mit den Seitenlautsprechern.

Line In-Anschluss (hellblau). Dieser Anschluss verbindet mit Tonband-, CD- oder
DVD-Playern oder anderen Audioquellen.

Mitte/Subwoofer-Anschluss (orange). Dieser Anschluss verbindet mit den Mitte-/
Subwoofer-Lautsprechern.

Hinterer Lautsprecherausgang (schwarz). Dieser Anschluss verbindet in einer 4-
Kanal-, 6-Kanal- oder 8-Kanal-Audiokonfiguration mit den hinteren Lautsprechern.

Die Funktionen der Audio-Ausgange in 2, 4, 6 oder 8-Kanalkonfigurationen entnehmen Sie
bitte der folgenden Audio-Konfigurationstabelle.

Audio 2, 4, 6, oder 8-Kanalkonfigurationen

Kopfhorer

Anschlusse 2-Kanal 4-Kanal 6-Kanal 8-Kanal
Hellblau Line In Line In Line In Line In
Hellgrin Line Out Front-Lautsprecher- Front-Lautsprecher- Front-Lautsprecher-

ausgang ausgang ausgang
Rosa Mic In Mic In Mic In Mic In
Orange - - Mitte/Subwoofer Mitte/Subwoofer
Hinterer Hinterer Hinterer
Schwarz -
Lautsprecherausgang Lautsprecherausgang | Lautsprecherausgang
Grau - - - Seitenlautsprecher

LAN (RJ-45)-Anschluss. Dieser Anschluss ermoglicht Gigabit-Verbindungen zu einem
Local Area Network (LAN) mittels eines Netzwerk-Hub.

ACT/LINK SPEED

LED LED
Aktivitats-/Verbindungs- LED  Geschwindigkeits-LED

- -
AUS Nicht verbunden | AUS 10Mbps-Verbindung -
ORANGE | Verbunden | ORANGE | 100Mbps-Verbindung
BLINKEND | Datenaktivitat | GREEN | 1Gbps-Verbindung LAN

Anschluss

ASUS CS6110



VGA-Anschluss. Dieser Anschluss ist fur einen VGA-Monitor oder andere VGA-
kompatible Gerate vorgesehen.

Kensington®-Schlossbuchse. Dieser Anschluss dient der Sicherung lhres Desktop
Pcs mit einem stabilen Objekt unter der Verwendung der Kensington®-kompatiblen
Sicherheitsprodukten.

Luftungsodffnungen. Diese Offnungen dienen der Luftzirkulation.

' \ Blockieren Sie NICHT die Luftungsoffnungen im Gehause. Stellen Sie immer adaquate
LA Ventilation fur Ihren Computer bereit.

Kapitel 1: Erste Schritte



Einrichten Ihres Computers

Dieser Abschnitt fuhrt Sie durch das AnschlieBen wesentlicher Hardware-Gerate wie einen
externen Monitor, Tastatur, Maus und Stromkabel an Ihren Computer.

AnschlieBen eines externen Monitors

Unter Verwendung einer ASUS Grafikkarte

Verbinden Sie den Monitor mit dem Anzeigeausgang der aufgesetzten ASUS Grafikkarte.
So verbinden Sie einen externen Monitor mit der ASUS Grafikkarte:

1. Verbinden Sie ein Monitor mit dem Anzeigeausgang der ASUS-Grafikkarte.
2. SchlieBen Sie den Monitor an die Stromversorgung an.

/ Die Anzeigeausgange der ASUS Grafikkarten kbnnen sich je nach Modell unterscheiden.

ASUS CS6110




AnschlieBen einer USB-Tastatur und USB-Maus

Verbinden Sie eine USB-Tastatur und USB-Maus mit den USB-Anschlussen auf der
Riicktafel (Ruckseite) lhres Computers.

/ Maus und Tastatur werden nicht in allen Regionen mitgeliefert.

AnschlieBen des Netzteils
So schlieBen Sie das Netzeil an:

1. Verbinden Sie das Stromkabel mit dem Netzteil.

2. Verbinden Sie das Netzteil mit dem DC (Gleichstrom)-Eingang auf
der Ruckseite Ihres Computers.

3. SchlieBen Sie das ganze Netzteil an die Stromversorgung an.

Kapitel 1: Erste Schritte



Ein-/Ausschalten lhres Computers.

Dieser Abschnitt beschreibt, wie Sie den Computer nach der Einrichtung Ein-/Ausschalten
kbnnen.

Computer einschalten

So schalten Sie den Computer ein:

1. Schalten Sie den Monitor ein.

Driicken Sie die Einschalttaste lhres Computers.

Warten Sie, bis das Betriebssystem automatisch hochladt.

Computer ausschalten
So schalten Sie den Computer aus:

1. SchlieBen Sie alle laufenden Anwendungen.

Klicken Sie im Windows®-Desktop auf E .

Klicken Sie auf (Herunterfahren), um das Betriebssystem
herunterzufahren.

ASUS CS6110



Verwenden von Windows® 7

Das erste Starten

Beim ersten Start Inres Computers erscheint eine Abfolge von Fenstern, um Sie durch die
Konfiguration der Grundeinstellungen Ihres Windows Windows® 7 Betriebssystems zu fuhren.

So fuhren Sie den Erststart aus:

1. Schalten Sie den Computer ein. Warten Sie einige Minuten, bis das Fenster Windows
einrichten (Set Up Windows) erscheint.

Wahlen Sie in der Dropdownliste lhre Sprache. Klicken Sie auf Weiter (Next).

Wahlen Sie aus der Dropdownliste Ihr Land (Country) oder Region, Zeit (Time) und
Wahrung (Currency) sowie Tastatur-Layout (Keyboard Layout). Klicken Sie auf
Next (Weiter).

4. Geben Sie einmalige Namen fir Benutzername (user name) und Computername
(Computer name) ein. Klicken Sie auf Weiter (Next).

5. Geben sie die benotigten Informationen ein, um lhr Kennwort einzurichten, und klicken
Sie auf Weiter (Next). Sie konnen auch auf Weiter (Next) klicken und diesen Schritt
ohne ein Kennwort einzugeben zu Uberspringen.

% Falls Sie spater einen Benutzernamen oder Kennwort einrichten mochten, beziehen Sie
sich auf den Abschnitt Benutzerkonto und Kennwort einrichten in diesem Kapitel.

6.  Lesen Sie sorgfaltig die Lizenzbedingungen (License terms). Wahlen Sie Ich
akzeptiere die Lizenzbedingungen (I accept the license terms) und klicken Sie auf
Weiter (Next).

7. Wahlen Sie zwischen Empfohlene Einstellungen verwenden (Use recommended
settings) oder Nur wichtige Updates installieren (Install important updates only),
um Sicherheitseinstellungen lhres Computers einzustellen. Um diesen Schritt zu
Uberspringen, wahlen Sie Spater nachfragen (Ask me later).

8.  Uberprufen Sie die Zeit- und Datumseinstellungen. Klicken Sie auf Weiter (Next).
Das System ladet die neuen Einstellungen und startet erneut. Sie kbnnen jetzt mit der
Verwendung lhres Computers beginnen.
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Windows® 7 Desktop verwenden

% Klicken Sie auf das Startsymbol E > Hilfe und Support (Help and Support), um weitere
— Informationen Uber Windows® 7 zu erhalten.

Startmeni

Taskleiste Infobereich

Das Startmenii verwenden

Das Startmenii ermoglicht Ihnen den Zugang zu Programmen, Anwendungen und anderen
nutzlichen Elementen auf Ihrem Computer. Ebenso bietet es Ihnen weitere Informationen
Uber Windows 7 durch die Funktionen von Hilfe und Support (Help and Support).

Elemente im Startmenii ausfuihren
So fuhren Sie Elemente im Startmeni aus:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol E
2. Wahlen Sie im Startmenl das Element, welches Sie ausfuhren mochten.

/ Sie konnen Programme, die Sie dauerhaft im Startmenii anzeigen mbchten, an das
- Startment anheften. Fur weitere Details beziehen Sie sich auf den Abschnitt Programme
an Startmenii oder Taskleiste anheften in diesem Kapitel.

Kapitel 2: Verwenden von Windows® 7



Das Element Getting Started verwenden
Das im Startmenu aufgelistete Element Erste

Schritte (Getting Started) enthalt Informationen ‘f_ . e

Uber allgemeine Aufgaben wie die Personalisierung * e 2 B

von Windows®, Hinzufiigen neuer Benutzer und : : - I

Dateitransfer, um Sie mit der Benutzeroberflache [ L z

von Windows® 7 vertraut zu machen. @ e s
P g

So verwenden Sie das Element Erste Schritte: [~ —

1. Klicken Sie in der Windows®-Taskleiste auf e Rt

das Startsymbol E, um das Startmenu zu
laden. -

2. Wabhlen Sie Erste Schritte (Getting Started). -
Eine Liste moglicher Aufgaben erscheint.
3. Wahlen Sie die gewuinschte Aufgabe. m

Taskleiste verwenden

Die Taskleiste ermoglicht das Starten und die Verwaltung der auf Ihrem Computer
installierten Programme oder Elemente.

Ein Programm aus der Taskleiste starten
So starten Sie ein Programm aus der Taskleiste:

. Klicken Sie auf ein Symbol in der Windows®-Taskleiste, um es zu auszufuhren. Klicken
Sie erneut auf das Symbol, um das Programm auszublenden.

% Sie kbnnen Programme, die Sie dauerhaft anzeigen mochten, an die Taskleiste anheften.
- Fur weitere Details beziehen Sie sich auf den Abschnitt Programme an Startment oder
Taskleiste anheften in diesem Kapitel.
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Elemente an die Sprunglisten anheften | g

| &) Bob Acn - Bob Ao

Ein Rechtsklick auf ein Symbol in der Taskleiste
ladet die Sprungliste (Jumplist), um lhnen
einen Schnellzugang zu Bezugslinks eines
Programms oder Elements zu erleichtern. Sie [ Wirsdowws Misdis Playse
konnen Elemente wie Webseiten-Favoriten, oft o Diees Programen vom des Taskisists |osen
verwendete Ordner oder Laufwerke sowie kurzlich -

abgespielte Mediendateien an die Sprungliste
(Jumplist) anheften.

Eufgaken

[ Line boute I musiqes

So heften Sie Elemente an die Sprungliste an:

1. Klicken Sie mit der rechten Maustaste ein Symbol in der Taskleiste an.

2. Klicken Sie mit der rechten Maustaste auf das gewlinschte Element in der Sprungliste
und wahlen Sie An diese Liste anheften (Pin to this list).

Elemente von der Sprungliste [osen

So losen Sie Elemente von der Sprungliste:

1. Klicken Sie mit der rechten Maustaste ein Symbol in der Taskleiste an.

2. Klicken Sie mit der rechten Maustaste auf das gewtinschte Element in der Sprungliste
und wahlen Sie Von dieser Liste [6sen (Unpin from this list).

Programme an Startmenii oder Taskleiste anheften
So heften Sie Programme ans Startmenii oder Taskleiste an:

1. Klicken Sie in der Windows®-Taskleiste auf das

L s L L]

Startsymbol E um das Startmen zu laden.
2. Klicken Sie mit der rechten Maustatste auf das
Gewlinschte Element.

3. Wahlen Sie An Taskleiste anheften (Pin to
Taskbar) oder An Startmeni anheften (Pin to
Start menu).

/ Sie kbnnen auch das Symbol eines Autgaben x '|

- aktuell ausgefuhrten Programms - B Wit
mit der rechten Maustaste
anklicken und Dieses Programm Kininatim
an Taskleiste anheften (Pin this o0 Diesi Froguimm an Tarkhaui anheltan
program to taskbar) auswahlen. B Forae schiicBen
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Programme vom Startmenii [6sen
So losen Sie Programme vom Startmenii:

1.

Programme von der Taskleiste [6sen

Klicken Sie in der Windows®-Taskleiste auf das Startsymbol E um das Startmeni zu
laden.

Klicken Sie mit der rechten Maustaste auf das gewlinschte Programm in der Startmeni
und wahlen Sie Von dieser Liste [6sen (Unpin from this list).

So losen Sie Programme von der Taskleiste: ' I
LR

R
| o Do Freoquarmm v der Lathlemte Kvan |

1.

Klicken Sie in der Taskleiste das
gewinschte Programm mit der rechten
Maustaste an und wahlen Sie Dieses
Programm von der Taskleiste losen
(Unpin this program from taskbar).

By E

Infobereich verwenden
In der Standardeinstellung sind folgende Symbole im Infobereich aufgelistet:

Benachrichtigung fur Wartungscenter

E Hier konnen Sie durch das Anklicken dieses Symbols Warnnachrichten/Benachrichtigungen
anzeigen und das Windows®-Wartungscenter laden.
Netzwerkverbindung

. Dieses Symbol zeigt den Verbindungsstatus und Signalstarke der Kabel- oder Drahtlos-
Netzwerkverbindung.

m Lautstarke
Zur Einstellung der Lautstarke klicken Sie auf dieses Symbol.

Warnnachricht anzeigen

So zeigen Sie eine Warnnachricht an:

Klicken Sie auf das Benchrichtigungs- ' WU

Ugws gituellen Frablems sikares

symbol E und dann auf die Nachricht,
um diese anzuzeigen.

% Fur weitere Details beziehen Sie sich auf den Abschnitt Windows®-Wartungscenter

verwenden in diesem Kapitel.

ASUS CG Serie
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Symbole und Benachrichtigungen anpassen

Sie kbnnen die Symbole und Benachrichtungen in der Taskleiste oder im Infobereich
wahlweise ein- oder ausblenden.

So passen Sie Symbole und Benachrichtungen an:

1. Klicken Sie im Infobreich auf das Pfeilsymbol E
Klicken Sie auf Anpassen (Customize).

3. Wahlen Sie in der Dropdownliste die gewlinschte Verhaltensweise von Symbolen oder
Elementen, die Sie anpassen mochten.

N . . w | op it d

b

Wk en Sie e Syenibolz und Berachrichriqunges aus, i auf der Tasieste angesegl werien
ol

e S hrmsc e e S e SR, i et s e Son MR e
Wl 142 o b el s s bbb pd 0 P bbats 1 Ly bk 4 b

trsiaie Hraes
T BT R T R =
B T L . o

L L e IS
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lhre Dateien und Ordner verwalten

Windows® Explorer verwenden

Mit Windows® Explorer konnen Sie lhre Dateien und Ordner ansehen, verwalten und
organisieren.

Windows® Explorer offnen
So offnen Sie den Windows Explorer:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol E um das Startmeni zu

laden.
2. Klicken Sie auf Computer, um den Windows Explorer zu dffnen.
Breadcrumb-Leiste Ansicht

LT Lt = — Suchleiste

Symbollgiste—f- rmmmm = tmmrp———n fep——— “- t@l  vorschau
-—— T

Navigations- | <07 L Jerbd
bereich 8 e —+4—Ansichtsbereich

. U | i

Dateien und Ordner durchsuchen
So durchsuchen Sie Dateien und Ordner:

1. Offnen sie Windows Explorer.
Suchen Sie im Navigations- oder Ansichtsbereich nach dem Ort |hrer Daten.

Klicken Sie in der Breadcrumb-Leiste auf den Pfeil, um den Inhalt eines Laufwerks
oder Ordners anzuzeigen.
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Datei-/Ordneransicht anpassen
So passen Sie die Datei-/Ordneransicht an:

B Tten gonde Symbscle

2 Gribe Symbals

1. Offnen Sie Windows Explorer.
12 Muitelgrole Symiole

Wahlen Sie im Navigationsbereich den Ort Ihrer Daten.
3. Klicken Sie in der Symbolleiste auf das Symbol Ansicht

= -

4. Bewegen Sie den Auswahlregler im Ansichtsmeni, um
die Ansicht der Datei oder des Ordners anzupassen.

e . femctt (R T T
Sie kbnnen auch mit der rechten Sedaninth B byl
Lo Maustaste den Ansichtsbereich st B serpleieick
irgendwo anklicken, Ansicht i sime lawra baragis
(View) wahlen und die gewuinschte i i
Ansichtsart bestimmen. rirgtag st Ll
mrrmmlgmg e Rl
Iy
e

Dateien ordnen

So ordnen Sie Dateien:

1. Offnen Sie Windows Explorer.

2. Klicken Sie im Feld Anordnen (Arrange by), um die Dropdownliste anzuzeigen.
3. Wahlen Sie die gewlnschte Anordnungsart.
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Dateien sortieren

So sortieren Sie Dateien: L e

1. Offnen Sie Windows Explorer. RIS T

2. Rechtsklicken Sie irgendwo im S % :_L_,
Ansichtsbereich. ol by

3. Wahlen Sie im erschienenen Kontextmeni ::_H:“"" —
Sortieren (Sort by) und dann die von lhnen )
gewunschte Sortierungsmethode. St

Dateien gruppieren Ao

So gruppieren Sie Dateien: e s .

Lemssren Sy ar

1. Offnen Sie Windows Explorer. s S ‘L

2. Rechtsklicken Sie irgendwo im =
Ansichtsbereich. lecmaipgpenia byr %I

3. Wahlen Sie im erschienenen Kontextmeni ,:w' 4 =l
Gruppieren (Group by) und dann die von Sgmsiritn
Ihnen gewtinschte Gruppierungsmethode.

Neuen Ordner hinzufugen

So fugen Sie einen neuen Ordner hinzu:

1. Offnen Sie Windows Explorer.

2. Klicken in der Taskleiste auf Neuer Cumiiein > Peghenfle s o News Qi
Ordner (New folder).

3. Wahlen Sie einen Namen fur den neuen

7

Ordner.

Sie kbnnen auch den
Ansichtsbereich mit der rechten
Maustaste anklicken und Neu
(New) > Ordner (Folder) wahlen.

ASUS CG Serie
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Dateien sichern

Ein Backup erstellen
So erstellen Sie ein Backup:

1. Klicken Sie auf E > Alle Programme (All Programs) > Wartung (Maintenance) >
Sichern und wiederherstellen (Backup and Restore).

2. Klicken Sie auf Sicherung einrichten (Set up backup). Klicken Sie auf Weiter (Next).

= vzt s bcbotnt 1 Satwm are Adebomidas =iy

R

Roienle do Spplrminants [igerw Dabrken cichern o miederheriielie

[ W e—— ki

‘\"-":"'l""-'-*':l- [ R —————— s

P b e b
Far darten § wwwin s smar T bas, ag e

4

3. Wahlen Sie einen Zielort fur Ihren Backup. Klicken Sie auf Weiter (Next).

4. Wahlen Sie entweder Auswahl durch Windows (empfohlen) (Let Windows choose
(recommended)) oder Auswahl durch Benutzer (Let me choose) fur Ihren Backup.

/ Falls Sie Auswahl durch Windows auswéahlen, wird Windows keine Programme, FAT-
- formatierte Dateien, Papierkorbdateien oder Temporare Dateien von 1GB oder mehr
sichern.

5. Folgen Sie den Bildschirmanweisungen, um den Vorgang abzuschlieBen.

System wiederherstellen

Die Funktion Windows®-Systemwiederherstellung legt einen Wiederherstellungspunkt an, in
dem die Systemeinstellungen des Computers an einem Zeitpunkt/Datum gespeichert werden.
Dies erlaubt Ihnen die Wiederherstellung oder das Ruckgangigmachen von Anderungen
Ihres Computersystems, ohne dass lhre personlichen Daten betroffen werden.

So stellen Sie das System wieder her:

1. SchlieBen Sie alle laufenden Anwendungen.

2. Klicken Sie auf E > Alle Programme (All Programs) > Zubehor (Accessories) >
Systemprogramme (System Tools) > Systemwiederherstellung (System Restore).

3. Folgen Sie den Bildschirmanweisungen, um den Vorgang abzuschlieBen.

Kapitel 2: Verwenden von Windows® 7



Computer schutzen

Windows® 7-Wartungscenter verwenden

Windows® 7-Wartungscenter hilft hnen bei Warnnachrichten und bietet Sicherheits-
informationen, Informationen zur Systemwartung sowie die Moglichkeit einer automatischen
Problembehandlung und Behebung haufig auftretender Computerprobleme.

% Sie kdnnen die Benachrichtungen selbst anpassen. Fur weitere Details beziehen Sie sich
auf den vorherigen Abschnitt Symbole und Benachrichtigungen anpassen in diesem
Kapitel.

Windows® 7-Wartungscenter ausfuhren
So fuhren Sie Windows® 7-Wartungscenter aus:

1. Klicken Sie zum Ausfuhren des Windows
7-Wartungscenter auf das Symbol E im
Infobereich und dann auf Wartungscenter
offnen (Open Action Center).

2. Klicken Sie im Windows 7-Wartungscenter auf die Aufgabe, die Sie ausfuhren

mochten.
B ® e ket § Sotee pad Sedhetder I e pe— )

f o
Warein o SRR fioane [latwien sichar nder wisdetheruslien

B bt wm e Gham
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Windows® Update verwenden

Windows Update erlaubt Ihnen den Abruf und Installation der neuesten Updates, um die
Sicherheit und Leistung lhres Computers zu verbessern.

Windows® Update ausfuhren
So fuhren Sie Windows® Update aus:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol E um das Startmenu zu

laden.

Wahlen Sie Alle Programme (All Programs) > Windows Update.

3. Klicken Sie im Windows Update-Fenster auf die Aufgabe, die Sie ausfiihren mochten.

it ey Seitrailaerst g
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Benutzerkonto und Kennwort erstellen

Sie kbnnen fur andere Personen, mit Zugriff auf lhren Computer, weitere Benutzerkonten

sowie Kennworter erstellen.

Ein Benutzerkonto erstellen
So kbnnen sie ein Benutzerkonto erstellen:

1.

[SAEE I

Klicken Sie in der Windows®-Taskleiste auf E > Erste Schritte (Getting Started) >

Neue Benutzer hinzufugen (Add new users).

Wahlen Sie Anderes Konto verwalten (Manage another account).
Wahlen Sie Neues Konto erstellen (Create a new account).
Geben Sie den neuen Benutzernamen ein.

Wahlen Sie den Benutzertyp, entweder Standardbenutzer (Standard user) oder
Administrator.

Zum Fertigstellen klicken Sie auf Konto erstellen (Create Account).

17, = Srmstzrhcm 0 Kowar smeatin 8 Raen bors s o iy [ Bttty skt B
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Benutzerkennwort erstellen
So erstellen Sie ein Benutzerkennwort:

1. Wahlen Sie den Benutzer, fur den Sie ein Kennwort erstellen mochten.

2. Wahlen Sie Kennwort erstellen (Create a password).

k]

e i y—— B0 e

et sgem A Krte: wirh BUT thoreh Fores

3. Geben Sie ein Kennwort ein und bestatigen Sie es. Geben Sie ein Kennworthinweis
ein.
4. Zum Fertigstellen klicken Sie auf Kennwort erstellen (Create password).

= [ i s g ]
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Antivirus-Software aktivieren

Trend Micro Internet Security ist eine auf Ihren Computer vorinstallierte Antivirus-Software.
Nach der Aktivierung kbnnen Sie es 60 Tage lang Probenutzen und eine lizenzierte Version
erwerben, nachdem die Probezeit abgelaufen ist.

So aktivieren Sie Trend Micro Internet Security:
1. Fuhren Sie die Anwendung Trend Micro Internet Security aus.

2. Lesen Sie sorgfaltig die Lizenzbedingungen (License terms). Klicken Sie auf
Zustimmen & Aktivieren (Agree & Activate).

Geben Sie |hre E-Mail-Adresse und lhren Standort ein. Klicken Sie auf Weiter (Next).
Klicken Sie auf Fertigstellen (Finish), um die Aktivierung abzuschlieBen.

Windows?® Hilfe und Support

Windows® Hilfe und Support bietet lhnen Anleitungen und Antworten fur die Verwendung der
Anwendungen auf der Windows® 7-Plattform.

Um Windows® Hilfe und Support zu laden, klicken Sie auf E > Hilfe und Support (Help
and Support).

Syl glne AnrsneT Fnden

[ |
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% Stellen Sie sicher, dass Sie mit dem Internet verbunden sind, um die aktuellste Windows®-
Onlinehilfe abrufen zu kbnnen.
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AnschlieBen von Geraten an Ihren Computer

AnschlieBen eines USB-Datentragers

Dieser Desktop PC enthalt USB 3.0/2.0-Anschlusse auf der Vorder- sowie Ruckseite. Die
USB-Anschlusse ermoglichen lhnen das AnschlieBen von USB-Geraten wie z.B. USB-
Datentrager.

So schlieBen Sie einen USB-Datentrager an:

Stecken Sie den USB-Datentrager in lhren Computer ein.

Vorderseite Ruckseite

So entfernen Sie einen USB-Datentrager:

1. Klicken Sie im Windows-Infobereich Ihres Computers 47y Geite und Drsier affnes

auf ! und dann auf USB2.0-Flahslaufwerk auswerfen
(Eject USB2.0 FlashDisk). Die Nachricht variiert je nach
Hersteller/Typ des Datentragers.

2. Wenn die Nachricht Hardware kann jetzt O o e
entfernt werden (Safe to Remove Hardware) B Gonat "Ll -Marasmigpas bapeeal” ban et spm

eingeblendet wird, entfernen Sie den USB- Chpvial MM
Datentrager von lhrem Computer.
// ;\ Entfernen Sie einen USB-Datentrager nicht wahrend eines laufenden Datentransfers. Dies

kann zu Datenverlust fuhren und den USB-Datentrager beschadigen.
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AnschlieBen von Mikrofon und Lautsprechern

Dieser Desktop PC enthalt Mikrofon- und Lautsprecheranschlusse auf der Vorder- sowie
Ruckseite. Die auf der Ruickseite gelegenen Audio E/A-Anschlusse ermoglichen lhnen den
Anschluss von 2-Kanal, 4-Kanal, 6-Kanal, and 8-Kanal Stereolautsprechern.

Anschluss von Kopfhorern und Mikrofon

AUDIO
INPUTS
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Anschluss von 4-Kanal Lautsprechern

AUDIO AUDIO
INPUTS INPUTS

Rear Front —

/WVI\
LJ]

o J

Anschluss von 6-Kanal Lautsprechern

AUDIO AUDIO AUDIO
INPUTS INPUTS INPUTS

©®®®

Rear  Front Center/
Subwoofer
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Anschluss von 8-Kanal Lautsprechern

Side Center/
Subwoofer
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AnschlieBen von mehreren externen Anzeigegeraten
Ihr Desktop PC enthalt VGA-, HDMI- und DVI-Anschlusse/Ausgange und ermoglicht lhnen
das Verbinden von mehreren externen Anzeigegeraten.

R Wenn eine Grafikkarte auf Ihren Computer installiert wurde, verbinden Sie die
Anzeigegerate mit den Anzeigeausgangen der Grafikkarte.

Einrichten mehrerer Anzeigegerate

Wenn Sie mehrere Monitore verwenden, kbnnen Sie die Anzeigemodi selbst bestimmen.
Sie kbnnen einen zusatlichen Monitor als ein Duplikat lhres Hauptmonitors oder als eine
Erweiterung lhres Windows Desktops verwenden.

So richten Sie mehrere Anzeigegerate ein:

1. Schalten Sie den Computer aus.

2. Verbinden Sie die zwei Monitore mit Inren Computer sowie die Netzteile mit den
Monitoren. Beziehen Sie sich auf den Abschnitt Einrichten lhres Computer in Kapitel
1 fur Details zum Verbinden eines Monitors mit lnrem Computer.

% Bei einigen Grafikkarten kann nur der zur Primaranzeige gesetzte Monitor eine Anzeige
- wahrend des POST lieferen. Die Dual-Anzeige-Funktion funktioniert nur unter Windows.

ASUS CS6110
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Schalten Sie den Computer ein.

4. Folgen Sei einer nachstehenden Vorgehensweisen, um das Einstellungsfenster

Bildschirmauflosung (Screen Resolution) zu 6ffnen:

+  Klicken Sie auf E > Systemsteuerung (Control Panel) > Darstellung und
Anpassung (Appearance and Personalization) > Anzeige (Display) >
Anzeigeeinstellungen andern (Change display settings).

+  Klicken Sie mit der rechten Maustaste irgendwo im Desktop. Wahlen
Sie im Kontextmenu Anpassen (Personalize) > Anzeige (Display) >
Anzeigeeinstellungen andern (Change display settings).

5. Wahlen Sie in der Dropdownliste Mehrere Anzeigen: (Multiple displays:) den

gewunschten Anzeigemodus.

+  Diese Anzeigen duplizieren (Duplicate these displays): Treffen Sie diese
Auswahl, um den zusatzlichen Monitor als einen Duplikat lhres Hauptmonitors zu
verwenden.

+  Diese Anzeigen erweitern (Extend these displays): Treffen Sie diese Auswahl,
um den zusatzlichen Monitor als eine Erweiterung lhres Hauptmonitors zu
verwenden. Dies vergroBert lhren Desktop.

Desktop nur auf 1/2 anzeigen (Show desktop only on 1/2): Treffen Sie diese
Auswahl, um den Desktop auf Monitor 1 oder Monitor 2 anzuzeigen.

Diesen Bildschirm entfernen (Remove this display): Treffen Sie diese
Auswahl, um den ausgewahlten Monitor zu entfernen.

Ty o gy 4 sy | By ar B mgm »

whe e T e Bl

6.  Klicken Sie auf Ubernehmen (Apply) oder auf OK und in der Bestatigungsnachricht
dann auf Anderungen beibehalten (Keep Changes).
i & —m " : ]
rGchten Sie diese Anzeigeeinstellungen |
beibehalen?
|

Anmsenangen beibehallen Wiedmihentellen

B 11 Sekunden s vorhenge Anceigesinsteliungsn
| rurichistien
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AnschlieBen eines HDTV
Verbinden Sie ein High-Definition TV (HDTV) mit dem HDMI-Anschluss Ihres Computers.

/ﬁ + Sie benotigen ein HDMI-Kabel, um ein HDTV mit dem Computer zu verbinden. Das
L HDMI-Kabel muss separat erworben werden.

+ Um die beste Anzeigeleistung zu erhalten, sollte das HDMI-Kabel kurrzer als 15 Meter
sein.

ASUS CS6110
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Computer verwenden

Richtige Sitzhaltung beim verwenden des Desktop PCs

Beim Verwenden des Desktop PCs ist die Einhaltung der richtigen Sitzhaltung erforderlich,
um Verspannungen lhrer Handgelenke, Hande und anderer Gelenke oder Muskeln zu
vermeiden. Dieser Abschnitt bietet lhnen Tipps zum Vermeiden von physischen Beschwerden
und moglichen Verletzungen beim Verwenden und Erfreuen lhres Desktop PCs.

Augen auf Augenhbhe mit
dem Ende des Monitors m

4

90°-Winkel

Fussablage

So konnen Sie die richtige Sitzhaltung sicherstellen:

Stellen Sie den Computerstuhl so ein, dass Ihre Ellbogen an oder etwas Uiber der
Tastatur ruhen, um eine bequeme Tastaturschreibposition zu gewahrleisten.

Stellen Sie die Hohe lhres Stuhls ein, so dass die Knie etwas uber lhren Huften liegen,
um die Ruckseiten Ihrer Schenkel zu entspannen. Verwenden Sie, falls erforderlich,
eine Fussablage, um lhre Knie anzuheben.

Stellen Sie die Rucklehne lhres Stuhls ein, so dass die Unterseite Ihres Ruckgrats fest
abgestutzt und etwas nach hinten gewinkelt wird.

Sitzen Sie aufrecht, so dass lhre Knie, Ellbogen und Huften beim Sitzen vor dem PC in
etwa einen 90°-Winkel bilden.

Stellen Sie den Monitor direkt vor Ihnen auf und passen die Position der Oberseite
Ihres Bildschirms so auf lhre Augenhbhe ein, dass lhre Augen etwas nach unten
blicken.

Platzieren Sie Ihre Maus nahe der Tastatur und verwenden Sie, falls notig, eine
Handgelenkablage, um den Druck auf Ihre Handgelenke wahrend des Tippens zu
senken.

. Verwenden Sie den Desktop PC in einer gutbeleuchteten Umgebung halten Sie ihn
von starken Lichtquellen wie Fenstern und direkten Sonnenlicht fern.

Legen Sie beim Arbeiten mit dem Desktop PC regulare Minipausen ein.
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Speicherkartenleser verwenden

Digitale Kameras und andere digitale Aufnahmegerate verwenden Speicherkarten, um
digitale Bilder oder Medien zu speichern. Der auf der Vorderseite Ihres Systems integrierte
Speicherkartenleser ermoglicht das Lesen und Schreiben von und zu unterschiedlichen

Speicherkarten.

So verwenden Sie eine Speicherkarte:
1. Offnen Sie die Abdeckung der E/A-Fronttafel an.
2. Stecken Sie eine Speicherkarte in den Kartensteckplatz.

% .

Eine Speicherkarte ist gekerbt und Iasst sich nur in eine Richtung einpassen. Stecken
Sie die Karte NICHT gewaltsam in einen Steckplatz, um Schaden an der Karte zu
vermeiden.

Sie kbnnen Speicherkarten in einen mehrere Steckplatze einstecken und jede davon
voneinander unabhangig verwenden. Verwenden Sie nur eine Speicherkarte pro
Steckplatz.

3. Wahlen Sie im AutoPlay-Fenster ein Programm, um auf die Dateien zuzugreifen.

7

Falls AutoPlay auf lhren Computer NICHT aktiviert ist, klicken Sie in der Taskleiste
von Windows® 7 auf die Start-Taste, klicken Sie auf Arbeitsplatz (Computer) und
doppelklicken Sie das Speicherkartensymbol, um auf die darauf enthaltenen Daten
zuzugreifen.

+ Jeder Speicherkartenleser hat ein eigenes Laufwerkssymbol, welches im Fenster

Arbeitsplatz (Computer) aufgelistet wird.

Die LED eines Speicherkartenlesers leuchtet auf und blinkt, wenn Daten auf die
Speicherkarte geschrieben oder von der Speicherkarte gelesen werden.

4. Wenn abgeschlossen, klicken Sie mit der rechten Maustaste auf das Laufwerkssymbol
im Fenster Arbeitsplatz (Computer), klicken Sie auf Auswerfen (Eject), und
entfernen Sie dann die Speicherkarte.

oder Loschen von Daten auf der Karte, da die Daten eventuell verloren gehen.

Um Datenverluste zu vermeiden, verwenden Sie die Funktion Hardware sicher entfernen

R Entfernen Sie eine Karte niemals wahrend oder nach dem Lesen, Kopieren, Formatieren
/ é\

und Medium auswerfen im Windows Infobereich, bevor Sie die Speicherkarte entfernen.
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Optisches Laufwerk verwenden

Optischen Datentrager einlegen
So legen Sie einen optischen Datentrager ein:

1. Drucken Sie beim eingeschalteten System die Auswurftaste, um das Laufwerk zu
offnen.

2. Legen Sie den Datentrager in das Laufwerk, wobei die bedruckte Seite nach oben
zeigt.

3. Drucken Sie auf das Laufwerksfach, um es zu schlieBen.
4. Wahlen Sie im Fenster AutoPlay ein Programm, um auf die Dateien zuzugreifen.
% Falls AutoPlay auf Ihren Computer NICHT aktiviert ist, klicken Sie in der Taskleiste von

Windows® 7 auf die Start-Taste, klicken Sie auf Arbeitsplatz (Computer) und doppelklicken
Sie das CD/DVD-Laufwerkssymbol, um auf die darauf enthaltenen Daten zuzugreifen.

Optischen Datentrager entfernen
So entfernen Sie einen optischen Datentrager:

1. Folgen Sie einer Vorgehensweise, um das Laufwerksfach auszuwerfen:
Driicken Sie die Auswurfstaste.

Klicken Sie im Fenster Arbeitsplatz (Computer) mit rechten Maustaste auf das
Laufwerkssymbol und wahlen Sie Auswerfen (Eject).

2. Entfernen Sie den Datentrager aus dem Laufwerksfach.

—~
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Einrichten der Internetverbindung

Kabelverbindung

Fur eine Verbindung zwischen Ihrem Computer und DSL-/Kabelmodem oder Lokalem
Netzwerk (Local Area Network / LAN), verwenden Sie ein RJ-45-Kabel.

Uber DSL-/Kabelmodem verbinden
So verbinden Sie via ein DSL-/Kabelmodem:

1. Richten Sie das DSL-/Kabelmodem ein.

/ Beziehen Sie sich auf die Dokumentation, die mit Inrem DSL-/Kabelmodem geliefert wurde.

2. Verbinden Sie ein Ende des RJ-45-Kabels mit dem LAN (RJ-45)-Anschluss auf der
Ruckseite Ihres Computers und das andere Ende mit dem DSL-/Kabelmodem.

RJ-45-Kabel

Schalten sie den DSL-/Kabelmodem und Computer ein.

Konfigurieren Sie die notigen Einstellungen fur die Internetverbindung.

/P Fur Details und Hilfestellung zur Einrichtung einer Internetverbindung wenden Sie sich an
- Ihren Internetdienstanbieter (ISP).
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Uber ein lokales Netzwerk (LAN) verbinden
So verbinden Sie sich via LAN:

2. Verbinden Sie ein Ende des RJ-45-Kabels mit dem LAN (RJ-45)-Anschluss auf der
Ruckseite Ihres Computers und das andere Ende mit dem (Internet) LAN.

RJ-45-Kabel

3. Schalten sie den Computer ein.

4. Konfigurieren Sie die notigen Einstellungen fur die Internetverbindung.

/ Fur Details und Hilfestellung zur Einrichtung einer Internetverbindung wenden Sie sich an
- Ihren Internetdienstanbieter (ISP).
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Verwenden der Hilfsprogramme

ASUS Al Manager

ASUS Al Manager ist ein Hilfsprogramm, welches Ihnen schnellen Zugriff auf oft verwendete
Anwendungen ermoglicht.

Al Manager installieren
So installieren Sie Al Manager:

1. Legen Sie die Support-DVD in das optische Laufwerk. Die DVD zeigt automatisch das
Treiber-Menu an, wenn Autorun auf lhrem Computer aktiviert ist.

/ Falls Autorun deaktiviert ist, doppelklicken Sie die Datei setup.exe im Ordner ASUS Al
Manager auf der Support-DVD.

2. Klicken Sie auf den Tab Hilfsprogramme (Utilities) und dann auf ASUS Al-Manager.
3. Folgen Sie den Bildschirmanweisungen, um die Installation fertigzustellen.

Al Manager starten

Um Al-Manager vom Windows®-Desktop zu starten, klicken Sie auf Start > Alle
Programme (All Programs) > ASUS > Al Manager > Al Manager 1.xx.xx. Die Al-Manager
Schnellstartleiste erscheint auf dem Desktop.

s[oN" L ET

Nach dem Start der Anwendung erscheint das Al-Manager-Symbol in der Windows®-
Taskleiste.

Klicken Sie mit der rechten Maustaste auf das Symbol, um
zwischen der Leiste und dem Hauptfenster umzuschalten und
den Al Manager entweder aus der Schnellstart-
oder der Taskleiste aus zu starten.

-

Misy '.ﬂ.T'r\.a‘!'Hr\Hr[F_-r-

Switch to Quick Bar
Switch to Main Window

Start at Quick Bar
v Start at ToolBar

Exit
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Al Manager Schnellstartleiste

Die Al Manager Schnellstartleiste halt Ihren Desktopplatz frei und ermoglicht das einfache
Starten von Hilfsprogrammen oder das Anzeigen von Systeminfos. Klicken Sie auf die
Auswahl Hauptfenster (Main), Meine Favoriten (My Favorites), Support oder Information, um
die Inhalte der entsprechenden Menuis anzuzeigen.

= SchlieBen
ﬂ ﬁ }%Vollbild
ol Minimieren

Hauptfenster Support ASUS-Anwendung
Meine Favoriten Information

Kiicken Sie auf IEl (Maximieren), um zwischen Vollbild und der Schnellstartleiste
umzuschalten. Klicken Sie auf [=] (Minimieren), um Al Manager in der Taskleiste zu
behalten. Klicken Sie auf =l (SchlieBen), um Al Manager zu schlieBen.

Hauptment

Das Hauptmenu enthalt funf Anwendungen: Al Disk, Al Security, Al Boosting, and Al
Probe. Klicken Sie das kleine Dreieck neben dem Symbol Hauptmenii, um die Anwendungen
im Hauptmeni einzublenden.

e

BRI AN Apn

g ’ |
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Elemente auf
der rechten
Seite anzeigen

Erweitern oder
wiederherstellen

Elemente auf der
linken Seite anzeigen

Al Disk
Al Disk ermbglicht Ihnen das einfache Loschen der temporaren Internetdateien, IE-
URLs, IE-Cookies, IE-Verlaufliste oder Papierkorb. Klicken Sie in der Schnellstartleiste
auf das Symbol Al Disk, um das Hauptfenster des Al Disk anzuzeigen und die
Elemente, die Sie [bschen mochten, auszuwahlen. Klicken Sie, wenn soweit, auf
Ubernehmen (Apply).
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Al Security

Al Security ermbglicht lhnen Kennworter fur Gerate, wie z.B. USB-Laufwerk und CD/
DVD-Laufwerk, einzurichten, und sie vor fremdem Zugriff zu sichern.

So sperren Sie ein Gerat:

1. Wenn Sie Al Security zum ersten Mal benutzen, geben Sie ein Kennwort ein,
welches nicht mehr als 20 Buchstaben, Zahlen oder Zeichen enthalt.

2. Bestatigen Sie lhr Kennwort.

Geben Sie einen Kennworthinweis ein (empfohlen).

Klicken Sie, wenn soweit, auf OK.
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5. Wahlen Sie das zu sperrende Gerat und klicken Sie dann auf Ubernehmen

(Apply).

6. Geben Sie das zuvor eingerichtete Kennwort ein und klicken Sie auf OK.

So entsperren Sie ein Gerat:

1. Wahlen Sie die Auswahl fur das gesperrte Gerat auf und klicken Sie auf

Ubernehmen (Apply).

2. Geben Sie das zuvor eingerichtete Kennwort ein und klicken Sie auf OK.

So andern Sie das Kennwort:

Klicken Sie auf Kennwort andern (Change Password) und folgen Sie den

Bildschirmanweisungen.

ASUS CS6110
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Al Booting

Mit Al Booting kbnnen Sie die Boot-Gerateprioritat festlegen.
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So legen Sie die Boot-Sequenz fest:

1. Wahlen Sie ein Gerat und klicken Sie dann auf die Tasten links/rechts, um die
Boot-Reihenfolge festzulegen.

2. Klicken Sie, wenn soweit, auf Ubernehmen (Apply).

Al Probe

Die aktuellen CPU- und Motherboardtemperaturen sowie CPU-Luftergeschwindigkeit
und Ausgangsspannung werden von Al Probe automatisch erkannt und angezeigt. Sie
konnen die Werte je nach Bedarf anpassen.

Klicken Sie auf die Auswahl Temperatur (Temperature), Spannung (Voltage) oder
Luftergeschwindigkeit (Fan Speed) und wahlen Sie ein Element, um es zu aktivieren
und den Wert durch verschieben des Reglers zu andern.
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Meine Favoriten

My Favorites (Meine Favoriten) ermoglicht Ihnen, Anwendungen die Sie dfter benutzen
hinzuzufugen, um diese schneller zu finden.
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So fugen Sie eine Anwendung hinzu:

1. Klicken Sie auf Hinzufugen (Add) und wahlen Sie dann die Anwendung, die Sie zu
Meine Favoriten (My Favorites) hinzufugen wollen.

2. Klicken Sie im Auswahlfenster auf

Offnen (Open). Die Anwendung wird zu Meine

Favoriten (My Favorites) hinzugefugt.

Klicken Sie mit der rechten Maustaste auf das Anwendungssymbol, um die entsprechende
Anwendung zu dffnen, ldschen oder umzubenennen. Doppelklicken Sie auf ein Symbol, um
die entsprechende Anwendung zu offnen.

Support

Klicken Sie im Fenster Support (Unterstuitzung) auf die Links, um zur ASUS-Webseite,

Webseite fur technische Unterstutzung,
Kontaktinformationen abzurufen.

Download-Webseite zu gelangen oder die
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Information

Klicken Sie im Fenster Information auf eine Auswahl, um weitere Informationen Ihres
Systems, Motherboards, CPU, BIOS, Speichers und der installierten Gerate anzuzeigen.

CPU Level Up

CPU Level Up ermoglicht das sofortige Ubertaken Ihres Systems in der Windows-

Umgebung, mit voreingestellten Ubertaktungsprofilen und ohne das umstandliche
Aufrufen des BIOS-Setup.

So starten Sie CPU Level Up:
1. Starten Sie Al Manager.

2. Klicken Sie auf ASUS-Anwendung (Asus Utility) und doppelklicken Sie auf
CPU Level Up.
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ASUS Update

Das ASUS Update-Programm gestattet lhnen, das Motherboard BIOS in der Windows®-
Umgebung zu verwalten, zu speichern und zu aktualisieren.

/ + ASUS Update benbtigt eine Internetverbindung tiber ein Netzwerk oder einen
Internetdienstanbieter (ISP)..

+ Das Programm befindet sich auf der dem Motherboardpaket beigelegten Support-DVD.

Installieren des ASUS Update
So installieren Sie ASUS Update:

1. Legen Sie die Support-DVD in das optische Laufwerk ein. Das Menu Treiber (Drivers)
wird gedffnet.

% Falls Autorun deaktiviert ist, doppelklicken Sie die Datei setup.exe im Ordner ASUS Update
auf der Support-DVD.

2. Klicken Sie auf die Auswahl Anwendungen (Utilities) und dann auf ASUS Update
installieren (Install ASUS Update).

3. Folgen Sie den Bildschirmanweisungen, um die Installation zu beenden.

% Beenden Sie alle Windows®-Anwendungen, bevor Sie das BIOS mit Hilfe dieses
Programms aktualisieren.

Aktualisieren des BIOS
So aktualisieren Sie das BIOS:

1. Starten Sie das Programm ASUS Update unter Windows®, indem Sie auf Start > Alle
Programme (All Programs) > ASUS > ASUSUpdate > ASUSUpdate klicken.
2. Wabhlen Sie in der Dropdownliste eine der folgenden Methoden:

Aktualisieren uiber das Internet (Updating from the Internet)

a. Wahlen Sie BIOS uiber das Internet aktualisieren (Update BIOS from the
Internet) aus dem Pulldownment und klicken dann auf Weiter (Next).

b.  Wahlen Sie die lhnen am nachsten gelegene ASUS FTP-Seite aus, um starken
Netzwerkverkehr zu vermeiden, oder klicken Sie auf Automatische Auswahl
(Auto Select). Klicken Sie auf Weiter (Next).

c.  Wahlen Sie die gewuinschte BIOS-Version auf der FTP-Seite aus. Klicken Sie auf
Weiter (Next).

/ Das ASUS Update-Programm kann sich Uber das Internet aktualisieren. Um alle
Funktionen des Programms nutzen zu konnen, aktualisieren Sie es bitte regelmaBig.
Aktualisieren iiber eine BIOS-Datei (Updating from a BIOS file)

a. Wahlen Sie BIOS uiber eine Datei aktualisieren (Update BIOS from a file) aus
dem Pulldownmeni und klicken dann auf Weiter (Next).

b.  Suchen Sie die BIOS-Datei im Fenster Offnen (Open) und klicken dann auf
Open (Offnen).

3. Folgen Sie den Anweisungen auf dem Bildschirm, um den Aktualisierungsprozess
abzuschlieBen.

ASUS CS6110
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ASUS MyLogo™

Das Hilfsprogramm ASUS MyLogo™ ermoglicht es Ihnen, das Boot-Logo Ihren Wiinschen
anzupassen. Ein Boot-Logo ist das Bild, welches wahrend des Power-On Self-Tests (POST)
erscheint. ASUS MyLogo™ wird automatisch mit dem ASUS Update-Hilfsprogramm von der
Support-DVD installiert.

R + Laden Sie die neueste BIOS-Version von der ASUS-Webseite unter www.asus.com

+ Sie kbnnen ein eigenes Boot-Logo-Bild im GIF-Format erstellen.

So starten Sie ASUS MyLogo™:

1.

6-8

Starten Sie das Hilfsprogramm ASUS Update. Details siche Abschnitt ASUS Update in
diesem Benutzerhandbuch.

Wahlen Sie Einstellungen (Options) aus der Liste und klicken Sie dann auf Weiter
(Next).

Markieren Sie die Auswahl MyLogo starten (Launch MyLogo), um das System-Boot-
Logo zu ersetzen, bevor Sie das BIOS aktualisieren, und klicken Sie dann auf Weiter
(Next).

Wahlen Sie BIOS uiber eine Datei aktualisieren (Update BIOS from a file) in der
Dropdownliste und klicken Sie dann auf Weiter (Next).

Wenn Sie dazu aufgefordert werden,
suchen Sie die neue BIOS-Datei und
klicken Sie dann auf Weiter (Next). Es
erscheint das ASUS MyLogo-Fenster.

Wahlen Sie in der linken Fensterhalfte ein
Bild, das Sie als Boot-Logo verwenden
mochten. Klicken Sie auf Weiter (Next).

Stellen Sie das Boot-Logo auf Ihre
gewlnschte GroBe ein, indem Sie einen
Wert im Feld Ratio auswahlen. Klicken
Sie auf Weiter (Next).

Das System beginnt mit der BIOS-Aktualisierung und ladet das neue Boot-Logo.

Nach der Aktualisierung des BIOS startet Inr Computer neu und das neue Boot-Logo
wird wahrend des POST angezeigt.
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Nero 9

Nero 9 ermbglicht lhnen das Erstellen, Kopieren, Brennen, Bearbeiten, Freigeben und
Aktualisieren von Daten verschiedenen Typs.

Nero 9 installieren
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So installieren Sie Nero 9:

1. Legen Sie die Nero 9 DVD in das optisches Laufwerk ein.

2. Falls Autorun aktiviert ist, erscheint automatisch das Hauptmenu.

% Falls Autorun deaktiviert ist, doppelklicken Sie die Datei SeupX.exe im Hauptverzeichnis
Ihrer Nero 9 DVD.

3. Klicken Sie im Hauptment auf Nero 9 Essentials.

Essentials

Sawn ¥ Lemendinh.
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ASUS CS6110

6-9



4. Wahlen Sie die gewlinschte Sprache fur den Installationsassistenten. Klicken Sie auf
Weiter (Next).
i

5. Klicken Sie auf Weiter (Next), um fortzufahren.
R

Liclien Son die Sorlommmenen BiY Moy 9 Dasiflih o
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6.  Wahlen Sie Ich akzeptiere die Lizenzbedingungen (I accept the License
Conditions). Wenn soweit, klicken Sie auf Weiter (Next).

e

Kapitel 6: Verwenden der Hilfsprogramme



7.

8.

9.

Wahlen Sie Typisch (Typical) und klicken Sie dann auf Weiter (Next).
.il i > O
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Wahlen Sie Ja, ich mdochte Anwendungsdaten anonym an Nero senden (Yes, |

want to help by sending anonymous application data to Nero) und klicken Sie

Weiter (Next).
i
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Dateien brennen
So brennen Sie Dateien:

1. Klicken Sie im Hauptmenu auf Daten brennen (Data Burning) > Hinzufugen (Add).
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2. Wahlen Sie die Dateien, die Sie brennen mochten. Wenn soweit, klicken Sie auf

Hinzufugen (Add).
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3. Nachdem Sie die Dateien zum Brennen ausgewahlet haben, klicken Sie auf Brennen
(Burn), um die Dateien auf einen Datentrager zu brennen.
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Fur weitere Details zur Verwendung von Nero 9, beziehen Sie sich auf die Nero Webseite
unter www.nero.com

7

Systemwiederherstellung

Die beigelegte Wiederherstellungs-DVD hilft Ihnen bei der reinstallation des Betriebsystems
und deren Wiederherstellung zum urspriinglichen Betriebszustand.
/'\\ Alle Daten gehen beim Wiederherstellungsvorgang verloren. Bevor Sie das
Lo System wiederherstellen, sollten Sie alle lhre Daten sichern und sich etwaige
Benutzereinstellungen wie Netzwerkeinstellungen notieren.

So verwenden Sie die Systemwiederherstellung:

1. Schalten Sie den ASUS Desktop PC ein. Driicken Sie beim Erscheinen des ASUS-
Logos auf <F8>, um zum Menu Please select boot device (Bitte Boot-Gerat
auswahlen) zu gelangen.

2. Legen Sie die Wiederherstellungs-DVD in das optische Laufwerk und wahlen Sie
das optische Laufwerk (CDROM:XXX) als das Boot-Gerat. Driicken Sie die Enter
(Eingabetaste) und dann eine beliebige Taste, um fortzufahren.

3. Warten Sie, bis das Fenster Hard-Disk Information (Festplatten-Informationen)
erscheint. Wahlen Sie zur Installation des neuen Systems einen Zielort. Sie haben
folgende Auswahimoglichkeiten:

Recover system to a partition (System auf eine Partition wiederherstellen)

Diese Option loscht nur die von lhnen gewahlte Partition und belasst die anderen
Partitionen in deren Zustand und erstellt eine neue Systempartition als Laufwerk “C”.
Wahlen Sie eine Partition und driicken Sie auf NEXT (Weiter).

Recover system to entire HD (System auf gesamte Festplatte wiederherstellen)

Diese Option loscht alle Partitionen auf lhrer Festplatte und erstellt eine neue
Systempartion als Laufwerk “C”. Wahlen Sie aus und klicken Sie auf Yes (Ja).
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4. Wahlen Sie | accept (Ich akzeptiere) und klicken Sie dann auf Next (Weiter).

5. Folgen Sie den Bildschirmanweisungen, um den Wiederherstellungsprozess
abzuschlieBen.

6.  Klicken Sie in der Bestatigungsnachricht auf OK, um den Datentrager aus dem
optischen Laufwerk auszuwerfen und das System neu zu starten.

7. Nach dem Systemneustart beginnt Windows® 7 mit der Systemkonfiguration. Folgen
Sie den Bildschirmanweisungen, um den Wiederherstellungsprozess abzuschlieBen
und das System neu zu starten.

R Die Wiederherstellungs-DVD wurde nur fur ASUS Desktop PCs erstellt. Verwenden Sie
die DVD NICHT bei anderen Computern. Fur aktuelle Updates besuchen Sie die ASUS-
Webseite unter www.asus.com

Schnelle Systemwiederherstellung

1. Schalten Sie den ASUS Desktop PC ein. Driicken Sie beim Erscheinen des ASUS-
Logos auf <F9>, um zur Systemwiederherstellung (System Recovery) zu gelangen.

2. Windows is loading files (Windows ladt Dateien) wird angezeigt. Warten Sie, bis
das Fenster Recovery CD/DVD (Wiederherstellungs-CD/DVD) erscheint.

3. Folgen Sie den Bildschirmanweisungen, um den Wiederherstellungsprozess
abzuschlieBen. Nach dem Systemneustart werden die Anzeigeauflosung und
Systemeinstellungen auf Standardwerte zuriickgesetzt.
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Problembehandlung

Problembehandlung

Diese Kapitel stellt einige Probleme vor, mit denen Sie konfrontiert werden kbnnten und bietet
einige Losungsansatze.

?  Mein Computer kann nicht eingeschaltet werden und die Betriebs-LED
auf der Vorderseite leuchtet nicht.

Prufen Sie, ob Ihr Computer richtig angeschlossen ist.
. Prufen Sie, ob die (Strom)Steckdose betriebsbereit ist.

. Prufen Sie, ob das Netzteil eingeschaltet ist. Beziehen Sie sich auf den
Abschnitt Ein-/Ausschalten Ihres Computers in Kapitel 1.

?  Mein Computer hangt.

Versuchen Sie folgendes, um Programme, die nicht reagieren, zu schlieBen:

1. Drucken Sie gleichzeitig auf die Tastaturtasten <Alt> + <Strg> + <Entf>
und dann auf Task-Manager starten (Start Task Manger).

2. Klicken Sie auf die Auswahl Anwendungen (Applications).

3. Wahlen Sie das nicht reagierende Programm und klicken Sie auf Task
beenden (End Task).

Falls die Tastatur nicht reagiert, driicken und halten Sie die Einschalttaste, bis
der Computer sich ausschaltet. Drucken Sie erneut auf die Einschalttaste, um
ihn wieder zu starten.

?  Ich kann mich mit der ASUS WLAN-Karte nicht mit dem Drahtlos-
Netzwerk verbinden (an bestimmten Modellen)?

Stellen Sie sicher, dass Sie fur das gewuinschte Netzwerk den richtigen
Netzwerkschlussel eingegeben haben.

. Verbinden Sie externe Antennen (wahlweise) mit den Antennenanschlissen
der ASUS WLAN-Karte und stellen Sie die Antennen auf die Oberseite lhres
Computer-Gehauses, um die beste drahtlose Netzwerkleistung zu erzielen.

72 Die Pfeiltasten auf der Zahlentastatur funktionieren nicht.

Prufen Sie, ob die Zahlensperre- (NUM)-LED ausgeschaltet ist. Falls die
NUM-LED an ist, werden die Tasten auf der Zahlentastatur nur fur die
Zahleneingabe genutzt. Falls Sie die Tasten auf der Zahlentastatur verwenden
mochten, drucken Sie die Taste NUM, um die NUM-LED auszuschalten.
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?  Keine Anzeige auf dem Monotor.

Prufen Sie, ob der Monitor eingeschaltet ist.

Prufen Sie, ob der Monitor richtig mit dem Videoausgang lhres Computers
verbunden ist.

. Falls Ihr Computer eine aufgesetzte Grafikkarte aufweist, sollten Sie den
Monitor mit dem Videoausgang der aufgesetzten Karte verbinden.

Prufen Sie, dass keine Pole am Videostecker verbogen sind. Falls Sie
verbogene Pole entdecken, ersetzen Sie das Videoverbindungskabel fur den
Monitor.

Prufen Sie, dass lhr Monitor richtig mit der Stromversorgung verbunden ist.

Fur weitere Informationen und erweiterte Problembehandlung, beziehen Sie
sich auf die mit dem Monitor mitgelieferte Dokumentation.

?  Beim Verwenden von zwei Monitoren liefert nur einer eine Anzeige.

Stellen Sie sicher, dass die beiden Monitore eingeschaltet sind.

Wahrend des POST hat nur der mit dem VGA-Anschluss verbundene Monitor
eine Anzeige. Die Dual-Anzeige funktioniert nur in der Windows-Umgebung.

Falls eine Grafikkarte auf lnrem Computer installiert ist, sollten die Monitore
mit den Ausgangen der Grafikkarte verbunden sein.

. Prufen Sie, ob die Einstellungen fur mehrere Anzeigegerate korrekt sind. Fur
Details beziehen Sie sich auf den Abschnitt AnschlieBen von mehreren
externen Anzeigegeraten in Kapital 3.

?  Mein Computer kann meinen USB-Datentréager nicht erkennen.

Beim ersten Verbinden eines USB-Datentragers mit lhrem Computer installiert
Windows automatisch einen entsprechenden Treiber fur das Gerat. Warten
Sie einen Moment und prufen Sie am Arbeitsplatz (My Computer), ob ein USB-
Datentrager erkannt wurde.

Verbinden Sie den USB-Datentrager mit einem anderen Computer um zu
prufen, ob der USB-Datentrager defekt ist oder eine Fehlfunktion aufweist.

?  Ich mochte die Systemeinstellungen meines Computers
wiederherstellen oder riickgangig machen, ohne meine personlichen
Dateien oder Daten zu beeinflussen.

Die Funktion Windows® Systemwiederherstellung ermoglicht Ihnen die
Wiederherstellung oder das Riickgangigmachen der Systemeinstellungen
Ihres Computers, ohne Einfluss auf Ihre personlichen Daten wie Dokumente
oder Fotos. Fur weitere Details beziehen Sie sich auf den Abschnitt System
wiederherstellen in Kapitel 2.

Kapitel 7: Problembehandlung



?  Das HDTV-Bild ist gestreckt.

Dies wird durch unterschiedliche Auflosungen lhres Monitors und HDTVs
verursacht. Passen Sie die Bildschirmauflosung lhres HDTVs an. So andern
Sie die Bildschirmauflosung:

1. Folgen Sie einer Vorgehensweise, um das Einstellungsfenster
Bildschirmauflbsunf (Screen Resolution) aufzurufen:

+ Klicken Sie auf > Systemsteuerung (Control Panel) > Darstellung
und Anpassung (Appearance and Personalization) > Anzeige
(Display) > Anzeigeeinstellungen Andern (Change display settings).

+ Klicken Sie mit der rechten Maustaste irgendwo im Desktop. Wahlen
Sie im Kontextmenii Anpassen (Personalize) > Anzeige (Display) >
Anzeigeeinstellungen andern (Change display settings).

2. Passen Sie die Auflosung an. Fur die richtige Auflosung beziehen Sie auf
die Dokumentation lhres HDTVs.

3. Klicken Sie auf Ubernehmen (Apply) oder auf OK und in der
Bestatigungsnachricht dann auf Anderungen beibehalten
(Keep Changes).

?  Meine Lautsprecher geben keinen Sound ab.

Stellen Sie sicher, dass die Lautsprecher mit dem Line-Out-Anschluss
(Hellgrun) auf der Vorderseite oder Ruckseite verbunden sind.

Prufen Sie, ob die Lautsprecher an die Stromversorgung angeschlossen und
eingeschalten sind.

. Passen Sie die Lautstarke lhrer Lautsprecher an.

Stellen Sie sicher, dass die Lautstarke des Systems nicht stummgeschaltet ist.
+  Falls stummgeschaltet, erscheint das Lautstarkesymbol als .Um
Lautstarke zu aktivieren, klicken Sie im Infobereich des Windows auf
und dann auf & .

Falls nicht stummgeschaltet, klicken Sie auf m und schieben Sie den
Regler, um die Lautstarke anzupassen.

. Um zu prifen, ob die Lautsprecher sachgemaBe funktionieren, verbinden Sie
die Lautsprecher mit einem anderen Computer.

?  Das DVD-Laufwerk kann den Datentrager nicht lesen.

. Prufen Sie, ob der Datentrager mit der bedruckten Seite nach oben eingelegt ist.

Prufen Sie, ob der Datentrager in der Mitte des Laufwerkfachs ausgerichtet ist,
insbesondere bei Datentragern anderer GroBen oder Formen.

. Prufen Sie, ob der Datentrager zerkratzt oder beschadigt ist.

?  Der Auswurfsknopf des DVD-Laufwerks reagiert nicht.

1. Klicken Sie auf E > Arbeitsplatz (Computer).

& &
. . . DW= Fow-Lawdwerk (Ox)
2. Kilicken Sie mit der rechten Maustaste auf -—$ , dann
auf Auswerfen (Eject) im Kontextmen.
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